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Translations

This topic provides a beginner-level overview of STEP's translation capabilities and assumes that the user has a
working knowledge of the STEP system. In this topic we will discuss the kinds of objects that are suitable for
translation, the various ways STEP enables users to translate content, and a primer on the various terms and
statuses users are likely to find while exporting content for translation. Detailed guidance covering other aspects of
the translation process, like executing XML and Excel exports, importing files, and handling errors, can be found in
their own topics.

STEP enables translation of a wide range of data. Using language-driven contexts, multiple translations can be
created for a single STEP object. This allows an object to be translated into multiple languages while the core
object retains all translated data and inter-language connections.

Briefly, STEP translation works like this: when a user exports, for example, a product hierarchy for translation, all
language-dependent attribute values for those products are extracted for translation. The content is then
translated, often by a translation vendor, and imported into STEP. All translated values flow into the appropriate
attribute in the relevant language context. The second time that same product hierarchy is extracted for
translation, the attribute values are evaluated as part of an automated process, and only those values that are new
or have amended content are extracted for translation.

It is important to note that STEP enables data to be translated but does not translate data itself. Throughout the
guidance on this subject you may see references made to 'starting translation' in STEP. This statement refers to
the act of exporting the to-be-translated content from STEP so it may be sent elsewhere for translation.

Translatable Objects
The object types in STEP that may be translated are:

« Products

» Classifications

« Asset names (names of images and documents, for example)
o Product values

o Indexwords

o LOV (List Of Values)

o Units

o Attribute names

o Freetextcellsintables

Translation Methods
The following methods are available in STEP to extract data for translation:

o Structured translation: Translatable data is exported from STEP into either an XML or Excel file. The file
can then be imported into the translation vendor's translation memory tool. Once the data has been
translated and sent back from the translation vendor, the updated file can be imported back into STEP,
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bringing all translated data into its relevant context. It is useful to note that translation XML files can only be
produced using the structured translation method.

« Manual Excel translation export: A more targeted export of translatable data into an Excel file. This
method is often used to quickly send small amounts of data to a translation vendor to address a late change
to already-exported data. Once the data has been translated and sent back from the translation vendor, the
Excel file can be imported back into STEP, bringing the translated data into its relevant context. All objects
can be translated using this method, except free text cells in tables and reference / link metadata.

« Manual translation: Data is translated directly in STEP, either by allowing a third-party translation vendor
direct access to STEP or by allowing an internal resource fluent in the target language to translate directly in
STEP.

« Asynchronous translation: For customers who engage translation vendors SDL or Lionbridge or use the
Across Language Server translation software to translate their content, a REST API can be set up that will
enable automatic transmission of translated content (in XML format) between STEP and the translation
servers. Another asynchronous option, the File Exchange Service, allows users a way to export and/or
import translation files to folders instead of using a translation service API.

Not all object types can be exported for translation into an XML and Excel file. The table below shows which
translation methods are available for which objects.

Structured Translation Manual Excel Manual Asynchronous
Translatable Translation Translation Translation
Object XML _ Excel _
Translation Translation
Product, v v v v v
classification,
asset names,
and values
Indexwords | + v v v v
Free text v ) 4 x v v
cellsin tables
LOVs v+ X v v v
Units X x o v X
Attribute v X v v v
names
Reference / v X X v v
link metadata
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*Exception: not available for LOV's configured a) to disallow new values or b) without value IDs assigned to the
LOV's values.

Translation Relations

In most instances, the objects being translated are subject to revision control, which requires that the data be
approved before it can be exported for translation. This requirement is in place to ensure that different revisions of
an object in translation remain clearly defined. Once the translation is complete, a translation relation is
established from the source language to the target language.

A translation relation refers to the relationship between an object's source language and the language the object is
being translated into, also known as the target language. For instance, if you translate an object in US English into
French, German, and Italian, you have created three translation relations: US English to French, US English to
German, and US English to Italian.

Translation of Local and Inherited Values

All values that are unique to a given object — also known as 'local' values — are extracted for translation. Local
values are non-inherited values; they are added directly to a given object.

Inherited values are values that are inherited from other objects at a higher level. They can be identified by a green
inverted triangle symbol (at+) that appears in the icon column. If an inherited value has already been translated at a

higher level, it will not be extracted for translation. When an inherited value is overwritten or revised in any way on
a given object, it becomes a local value to that object. If that higher-level value is then edited, that edit will not affect
the now-local value as it is no longer inherited from that higher-level value.

For more information on inheritance, see the Inheritance in the Product Hierarchy topic in the Getting
Started / User Guide.

Translation terms
When managing translations, it's important to understand the terms that reference the various languages involved
in the translation process:

o Master language: The first language used as source language
» Source language: The language from which a translation originates
o Target language: The language being translated into
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A source language may be translated into as many target languages as have been set-up on a given STEP
system. In the screenshot below, you can see the Status tab on an object. The user has selected English as the
master language for this object. The user has also elected to translate the object into five target languages: UK
English, German, Hebrew, French, and Danish.

12-GGK79 rev.0.64 - Status

Product || Sub Products || References || Referenced By |Images&Dncuments Proof View @ State Log |Tasks
_

@ Translation
Master : [Eﬂgﬁsh ‘]
Source *» Target * [Status >
* English LIK English Re-Translation Meeded
* English German In Progress
* English Hebrew Re-Translation Meeded
* English French Re-Translation Meeded

Translation Status

On each classification, product, attribute, or asset, you can view an object's translation status, which is the value
appearing in the Status column in the above screenshot. There are two ways to view the translation status of an
object:

« Inthe Tree, select the relevant object, and then click the Status tab. The view will resemble the screenshot
above.

« Inthe Search tab, search for the translation status of specific object types. For more on searching for
translation status, see the Searching for Translation Status topic.

In the collapsible Translation section of the Status tab content, the third column is 'Status.' For each Translation
Relation listed in this section, a status is displayed. One of the three statuses listed below will appear:

Status Description

Re- Translated content in the source language has changed since the most recent translation
Translation | completed. This status indicates a re-translation from the source into the target language is
Needed needed to bring all content up to date.

Upto Date | Notranslated contentin the source language has been changed since the previous translation.
Translation from source language into target language is up to date.
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Status Description

In A translation extraction has been done and is currently running as an active background process.
Progress Once the translated content has come back from the translation vendor and the file has been
imported, the background process will complete and the status will update to Up to Date.

Additional settings can be applied to all STEP translations by accessing the 'Users & Groups' node on the 'System
Setup' tab in the workbench. This is where users can configure how translation files are named, whether the 'Filter
spreadsheet’ parameter should display in the 'Request Translation' wizard, and, if so, what the default value
should be, and what attributes should always be excluded in translations. For more information on these settings,
see the Translation Settings section of the System Setup / Super User Guide documentation.
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Preparing Data for Translation

This topic describes how to configure data so that when a user exports content for translation, that data is included
in the translation export file. Users who read and understand this topic should be able to make objects language
dependent, which will in turn make them suitable to be exported for translation. For a more general overview of the
STEP translation functionality, see the Translations topic within this guide.

To translate contentin STEP, the various data values that comprise that content must be defined as "translatable".
For example, a customer name may not be useful to translate as it is the same no matter what language or country
it appears in. However, a product's short description would be useful to translate as that description text,
translated into the native language of the target market, would make it more effective.

To define an attribute or other object as translatable, that object must be designated as language dependent.
Typically, this is done as part of the initial data model when content is first brought into STEP, but it can also be
done after an object has already been added.

Listed below are the various methods used to make objects language dependent.

Specifying language dependency

Before objects in a hierarchy may be extracted for translation, the user must specify which attributes, object types,
and table types associated with that object will be language dependent.

Specifying language dependency at attribute creation

The most standard way to assign language dependency to an attribute is through the Create Attribute wizard
when attributes are first being defined.

Step six in the Create Attribute wizard is called Apply Dimension Dependencies (screenshot below).
Checking the Language checkbox designates the attribute being created as translatable. When this attribute is
part of a translation export and its status is either Never Been Translated or Requires Re-Translation, this
attribute's value will be included in the export file for translation.

To read more about the attribute creation process, review the Creating Attributes topic in the System Setup /
Super User Guide documentation.
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Create Attribute

Steps Apply Dimension Dependencies

1, select Attribute Group
2. Enter ID and MName

3. Enter Validation Rule
4, Select Urit(s) [] Country
5. Valid For Lanquage:
6. Apply Dimension Dependencies
7. Link to Hierarchy

Back Mext Finish Cancel

Specifying language dependency on existing attributes

A language dependency can also be applied to any existing attribute by going directly into the attribute via the

System Setup tab.

1. In System Setup, expand Attribute Groups, and then select the relevant attribute.

2. Onthe Attribute tab, in the Dimension Dependencies field, first double click inside the Value cell, and then
click the ellipsis button (...|).

3. Inthe Select Dimension Dependencies dialog (pictured below), click the box beside Language, and then
click Apply.

System Setup Cable/Wire Type - Attribute
=5 Attribute Groups & M References || Attribube Transformation || Validity || Profile State Log || Tasks
-3 Attribute Group "
[=-[£5 Category Spedific Attributes Name s[5 Walue .
H-[ Computers
> D CableWireT:
-5 New_Attribute_Group TS
-] Air qauge induded > Mame Cable Wire Type
~/]§ Alowable Ampacities » Last edited by 2015-11-05 15:18:34 by LATO
~{|§ Batteries Induded > Full Text Indexable N
DI Battery Type Select Dimension Dependencies
|]I Brightness * Externally Maintain
-{|f cable/wire Type » Hierarchical Filtering ity
(1§ Capadty > Calculated Language
(] Circular Area (cmils) -
>
~/]§ Conductor Gauge b Level of difficulty of applying changes: 0
/] co-op > Dimension Depende D
, Operation might be time consuming
|]I CSA Listed * Mandatory
(| DC Resistance (ohms) )
~{|f Diameter (mils) ? fryptographic Key Cance
[1F Mimr Mirmmmeinma * |Attribute Helo Text
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Checking Language will designate the attribute as translatable. This means that when a translation export is
initiated that includes this attribute, this attribute's value will be included in the export file. For more information on
editing attributes, see the Editing Attribute Values documentation.

Specifying language dependency on System Setup objects

A language dependency can also be applied to objects at the level of the object type. Applying the language
dependency means that all objects of the object type you configure will make the name of that object type
language dependent. Using the sales item object type as an example, if we apply language dependency to the
sales item object type, then all sales items names can be exported for translation. It does not mean that all sales
item values now have a language dependency.

To apply language dependency to an object type, users should follow these steps:

System Setup Sales Item - Object Type
l [T Alternate Classifications References || Log

_.‘Assets & Descript p

lﬁ‘ Basic Object Types | >T> lva .
-85 Commerdial Types ame f—
lﬁ Entity user-type root » D SalesTtem
@’ Event Queue Object Types * Mame | Sales Ttem |
E}"E-F;m;_w P";d”d:;asjﬁzh“” > Last edited by 2016-10-05 10:59:52 by USERJ
- iscontinued Produ
{%' External Products > Name Pattern
- ackaging Hierarchy > attern i
- fjii Packaging Hierarch ID Patte lid]
&[5 Primary Product Classification > Manually Sorted s
-] Product Overrides
E|r_=| Products » Enable Profiing fes
=[] Levell » InDesign Template Allowed Mo
E|r_=| Level2 s Tcon IL
8 Level3
= E?t& Dimension Dependendies |Z|
4. m %
‘ Ttem Folder » Reference Target Lock Policy|  Strict
r_=| Level4
Elr_=| Sales Item Folder
. alesItemFamily 1l niry
-5 SalesItemFamil i [ Countr
}%’ Product-Overrides F = Languag&
+-(2 Publication group types

Level of difficulty of applying changes: 0

o o

+-(# Publication types
+-(; Setup Group type root
% Tags

¥ Uniits

L | lamre B Gronine

[
[
E}-@’ Publication section types
=
£

Operation might be time consuming

o o

o

imal

o

coe

1. In System Setup, expand the Object Types & Structures node, and then select the relevant object type.
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2. Onthe Object Type tab, in the Dimension Dependencies field, first double click in the Value cell, and then
click the ellipsis button (|...)).

3. Inthe Select Dimension Dependencies dialog that displays, click the box beside Language, and then click
Apply.

Specifying language dependency on table types

STEP also enables language dependency to be set by table type. This enables any free text elementsin a
language-dependent table to be included in a translation export.

To apply a language dependency to a table type, follow these steps:

1. In System Setup, expand Table, and then select the relevant table type. In this example, the table type is
Pivot Table.

System Setup

Pivot Table - Table Type

@ Users & Groups B Table Type
"h Reference Types N
+ Workspaces Mame »| » |Value 5
El"ﬁ Table * MName Pivot Table
? Colors » Edited by 2016-08-09 16:15:03 by USERA =
- Rules
* :0. :0. :0. ight:0.
EI"% Table Types Defaults Rule Above:0.5 pt Rule Below:0. 5 pt Rule Left:0.5 pt Rule Right:0.5 pt
- CfPivot Tables » Dimension Dependendes
= il * Pagination Plugin Mone
..... MooT—
..... M CompactPartio §legdRowTypss
..... | Compact Price Default * [Name »
""" fif] Compact Specification Right » Column Header Row
""" (] oummy » 1B Compact Bottom Row 1

----- Ml LH compact Specifications
----- ] rRH Compact Specifeations
----- i RedBald >

Compact Header Row 1

(SRR RIE L]

Compact Header Row 2

2. Onthe Table Type tab, in the Dimension Dependencies field, click the ellipsis button (D).
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=+ £ Table Types

E--% Pivot Tables
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Pivot Table - Table Type

Table Type

Mame ¥ ¥ [Value ] il
> Name Pivot Table
> Edited by 2016-08-09 16:15:03 by USERA =
» Defaults Rule Above:D.5 pt Rule Below:0.5 pt Rule Left:0.5 pt Rule Right:0.5 pt
» Dimension Dependencies |[Z] [
* Pagination Plugin Mone
¥
Default > |Name >
@
* 1D
> 18
s 19 (Compact Header Row 2

Inthe Select Dimension Dependencies dialog, select Language, and then click Apply.

System Setup

l._ Reference Types
=] Table

}& Colors

(ﬁ Rules

=+ Cfy Table Types
E% Pivot Tables

& ] Pivat Table:

..... m Compact Partho
..... il Compact Price
..... m Compact Spedification Right

----- ] LH Compact Specifications
----- i rRH Compact Spedifeations
----- i rRedBold

----- il spec Column

----- ] spedfication

----- [T Column Header Row

----- |m Compact Bottom Row 1
..... M Compact Header Row 1
----- M Compact Header Row 2

----- M Mormal Row

m

@ Users & Groups s

Pivot Table - Table Type

Table Type

Mame 3|3 Value | *
> Name Pivot Table
> Edited by 2016-08-09 16:15:03 by USERA
» Defaults Rule Above:0.5 pt Rule Below:0. 5 pt Rule Left:0.5 pt Rule Right:0.5 pt
*» Dimension Dependencies ‘E]
* Pagination Plugin Mone

>

> ] [l country

i Level of difficulty of applying changes: 0

; Operation might be time consuming

9 [heoy || cancel _
s RAld
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Structured Translation

Translating content using the structured method is how most STEP users translate large amounts of data. By
selecting objects and initiating the Request Translation Wizard, STEP walks the user through creation of a
translation export XML or Excel file. This section of the translation guide covers:

o Structured XML Translation

o Structured Excel Translation

o Starting a Structured Translation

o Structured Translation of Setup Objects
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Structured XML Translation

In this topic, the basics of exporting translation data into an XML file via the structured translation method will be
covered at a high level, with more detail about the various aspects of STEP translation appearing in other sub-
topics.

Of the available translation options, exporting translatable data to XML using the structured translation format
works best for handling large amounts of content, and is well-suited for enabling automated translation solutions.

When an XML translation export is initiated, an XML file is delivered to a recipient via a configurable delivery
method. The file is sent to a translation vendor where the XML is translated into a target language. When the
updated file is imported back into STEP, all of the translated values are brought into their appropriate attributes.
The method of XML translation that is most often employed involves a STEP user sending an XML export file to a
translation vendor. The XML will be read by the vendor's XML parser, and the information stored in their
translation memory. The vendor's specific methodology, such as reading XML, sending content to an in-country
linguist, QCing the linguist's work, re-importing the content into the vendor's own tool, etc., will process that
translation task and send the content back to the STEP user to be imported.

The STEPXML Translation also works best when sending content to a vendor that uses a translation memory tool.
For translation work being sent to a vendor that does not have a translation memory tool, an Excel export may be
the better option. For more information on the structured Excel translation export, see the Structured Excel
Translation documentation.

The following objects can be extracted into an XML file for translation:

» Data objects, or objects that contain usable customer data

« Productvalues

« Classifications

« Freetextcellsintables

« Indexwords

» Asset names (names of images and documents, for example)
« Setup objects, or objects that help organize the data objects

« Asset names (names of images and documents, for example)

o LOVs

o LOV names

« Attribute names (including meta-attributes on attributes)

Itis important to note that setup objects are not under revision control and, therefore, do not require approval to be
exported for translation.

Structured Translation Export to XML
A structured translation extraction can be started through the Request Translation Wizard method.
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To start a structured translation XML export, click the File menu, point to Translate in the dropdown, and then
select Data Objects or Setup Objects.

File View Mavigate Format Maintain Window Help

Translate (720 i Data Dbjecls..a

Import : Setup Objects...

Export : Manual Excel Translation Export
@: Reports a Import Translation...

Bulk Update 3 Change Translation

Once a user has gone through the Request Translation Wizard this process initiates, they will be able to retrieve
their translation file in the Background Processes tab. These steps are covered in detail in the Starting a
Structured Translation documentation.

For more information about translating setup objects, review the Structured Translation for Setup Objects
documentation.

Useful Facts About Translation XML

XML Translation Export

When a product hierarchy is exported for translation as an XML file, all attribute values and free text cells are
analyzed by STEP's validation to identify the objects that need translation. This information is displayed in the
Feedback step of the Request Translation Wizard.

Tagging of Translatable Text

The export process results in an XML file in which content that appears between the <TranslatableText> tags
contain the attribute values and free text cell values that need translation.

Tagging of Partial Translation

The first time a product is translated into a target language, all language dependent values are extracted.
However, the next time that product is exported for translation into the same target language, only new or changed
values are extracted and appear between <TranslatableText> tags in the exported XML file. This is called partial
translation.

Translation of Free Text Cells in Tables

Using the structured translation method, you can translate free text cells in tables if the table type in question has
been pre-defined as language dependent.
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Structured Excel Translation

This topic provides an overview of the basics of exporting translation data into a Microsoft® Excel file using the
structured translation method. In this guide, users will learn which objects can be exported into an Excel document
for translation, where in the workbench a structured Excel translation export can be started, and how to read an
Excel translation export document.

Exporting translation data into an Excel file using the structured translation method enables manual translation of
content within an Excel file. When the translation has been completed, the updated Excel file can then be imported
back into STEP, bringing all of the translated values into their appropriate attribute.

Of the three methods available to extract content from STEP for translation, the structured Excel translation
method is best deployed when:

« there is a small amount of content to be translated
« the translation vendor does not make use of a translation memory tool

If either of these criteria are not met, the structured XML translation export is often the better option. For more
information on this, see the Structured XML Translation documentation.

One potential drawback to this translation method is that there is a greater chance of introducing data
inconsistency into the object being translated. This stems from the fact that the translated values are entered
manually by the translation vendor; adding the data correctly requires additional care to be taken by the user.
Further, special characters like the greater-than and less-than symbols (> and <, respectively), double and single
quotes, or the double prime (to denote lengths measured in inches), must be mapped in STEP prior to export. If
this is not done, the file is likely to error on import.

The following objects can be extracted into an Excel file for translation:
Data objects, or objects that contain usable customer data:

o Productvalues

« Classifications

o Product

» Asset names (names of images and documents, for example)

Setup objects, or objects like LOVs and attribute names that help organize the data objects, cannot be exported
to an Excel using the structured translation process. The Manual Excel Translation Export is the only method
available to bring these objects into an Excel file.

For more information on which objects can make use of which translation methods, see the Translations
documentation.
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Excel Translation Export

An Excel translation extraction can be started either through the structured Request Translation Wizard
method, or by selecting the Manual Excel Translation Export option. For more information on the Manual Excel
Translation Export option, see the Starting a Manual Excel Translation Export documentation.

To start a structured Excel translation from the File menu, first point to Translate and then select Data Objects.

Fileo View Mavigate Format Maintain Window Help

Translatea } Data Ohbj ects.e

Import Setup Objects...

Export Manual Excel Translation Export
@ Reports @ Import Translation...

Bulk Update Change Translation

Once a user has gone through the Request Translation wizard this process initiates, they will be able to retrieve
their translation file in the Background Processes tab. These steps are covered in detail in the Starting a
Structured Translation documentation.

Itis important to note that LOVs, units, and attribute names, also called setup data, cannot be translated within the
structured Request Translation wizard method of exporting translatable content to an Excel file. They can be
exported for translation using either the manual translation method, or by executing a Manual Excel Translation
Export.

See the table below for a breakdown of which objects can be exported using the structured and manual Excel
translation export methods.

Translatable Object Structured Excel Manual Excel
Translation Translation

Products, classifications, and image and document o o

names

Product values - -

LOVs X v

Attribute names X o

Units X o

For more on translating setup objects, see the Structured Translation for Setup Objects documentation.
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Translation Excel File Features

The Excel file features a color-coded cell format that quickly alerts the user to each element's status. Below is a
sample of what a user might find in an exported Excel file:

_lo/x
A B | C =
Product: Battery 3638

3

4 Source: English Target: German
5 1D Battery 3635 Battery 3635

E |[Name Battery 3638 Battery 3638

7 |Text attribute Jtext{ Thiz battery can last forever

8 |Attribute 1 [text{110i

9 |Key words [text{500

10

11 Product: Battery 4242

12 Source: English Target: German
13 1D Battery 4242 Battery 4242

14 [Name Battery 4242 Battery 4242

15 [Text attribute [text{ This battery cannot last for ever and ever
16 [Attribute 1 [text(110 =
17 |Key words Jtext{500

18

4
M 4 ¢ M[%Translation sheet / | ] I LI =

There are only four cell-shading colors a user may encounter in an Excel export file:

Background color Description

Blue The product name

Green Product information to be translated

Yellow Product information that does not need translation

White Product information that has already been translated and approved

The first time a product is translated into a target language, all values are extracted; however, the next time the
same product is exported for translation into the same target language, only new or changed values are extracted.

If one value in a multi-valued attribute is modified in the source language, then all values are extracted for
translation again.
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To translate all values again regardless of their previous translation status, on the Status tab, under Translation,
in the Status column, select Re-translation Needed.

Excel Translation Import

When you import an Excel translation file, the translated values are imported into the STEP database. The
structured translation process controls the entire import process, regardless of how the Excel file was exported.
For more information on importing Excel files generated through the Request Translation wizard, see the
Importing Translation Excel Files documentation.

© Stibo Systems - Confidential - Release 10.1-MP4 (April 20, 2021) 20



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Starting a Structured Translation

This topic describes, step-by-step, how to initiate a structured translation export of STEP content into an Excel or
XML file. Users who read and understand this topic should be able to produce a file suitable to send to a third-party
translation vendor for translation. Other translation methods supported in STEP are covered in their own topics.

To initiate a structured translation export you must access the Request Translation - Data Objectswizard. To
do so, open the File dropdown from the menu bar, select Translation, and then click Data Objects... (initiating
an export for Setup Objects is covered in the Structured Translation for Setup Objects documentation.

File o‘u'iew Mavigate Format Maintain Window Help

Translatee 3I Data Objects..

Import : Setup ijectsp

Export : Manual Excel Translation Export
7 Reports .@ Import Translation...

Bulk Update : Change Translation

The Request Translation - Data Objects wizard guides the user through the six steps that enable the user to
adapt the translation export to their specific requirements.

Step 1 - Select Configuration

Request Translation - Data Objects

Steps Select Configuration

1. Select Configuration

2. Object Selection

3. Filter

4. Select Target Language (O Use Existing Translation Configuration
5. Feedback
6. Delvery

® Create New Translation Configuration;

Back MNext Finish Cancel

The first step in the Request Translation - Data Objects wizard is Select Configuration. With the appropriate
radio button selected, the user can select an existing translation configuration by clicking the ellipsis button (|...|)

and selecting the desired configuration, or create a new translation configuration.
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Step 2 - Object Selection

Request Translation - Data Objects

Steps Object Selection
1. Select Configuration ~ gelaction
2. Object Selection (®) From Root Node
e Root Mode
4, Select T t Language
= () From List
5. Feedback
List File
6. Delivery
File Contains Product IDs
() From Collection
Collection
Refresh Automatically
Back Mext Finish

The second step in the Request Translation - Data Objects wizard is Object Selection. In this step, the user
selects which objects should be included in the translation export, and from where in STEP the objects should be

pulled.

There are three ways to select objects.

- Selection
{®) From Foot Mode

Root Node
{_) From List

List File

File Contains Product IDs
(") From Collection

Collection

Refresh Automatically

« From Root Node: For importing objects directly from the Tree. If the user has started the Request
Translation - Data Objects wizard while an object in the Tree is selected, that object will pre-populate the
Root Node field. If the user wishes to change the selection, clicking the |-=:| button will bring up a screen
allowing the user to either Browse the Tree for the object, or Search for the object by typing the sought-for
object directly into the search field.

« From List: Forimporting a file with data to be translated. This is different from the structured translation
import function (covered in detail in the Importing Translation Excel Files documentation and the Importing
Translation XML files documentation) in that the file being imported does not contain already-translated
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content. In the field entitled List File, click the E button to browse or search your computer's folders for the
appropriate file. In the File Contains field, click inside the field to display a dropdown. Select from the listed
options whether the data being imported contains Product IDs, Product Names, Classification IDs,
Classification Names, Asset IDs, or Asset Names. There is no option to multi-select.

« From Collection: For importing a manually selected grouping of various object types (which can,

potentially, be from multiple super types) grouped in a collection. In the Collection field, click the E button
and either browse or search for the collection to be translated. If the collection is based on a search and you
want to ensure that new or amended values in the collection are captured prior to exporting for translation,
click the box beside Refresh Automatically.

Step 3 - Filter

Regquest Translation - Data Objects

Steps Filter

1. Select Configuration ~Filter Options

2. Object Selection Indude [] Mot Translated  [#] Re-Translation Needed

3. Filter

4 Select Taraet 1 Approval Reguirement  [»] Completely Approved Source

5. Feedback Indude Super Types | Products e |

&. Delivery Indude Object Types | <Al ohject types > ||Z|
Exduded Attributes | DC_Attributes;Desk Colars "Z‘
Contextual Attributes | Country Code;Size ||Z|

| Back | | Next | Fmish Cancel

The third step in the Request Translation - Data Objects wizard is Filter. In this step, the user selects various
filtering options for the translation.

« Include: Users may elect to include or exclude values that are Not Translated or values that have been
amended and are thus designated as Re-Translation Needed. Click the boxes next to each to include them
in the filter. One or both must be checked to proceed. Otherwise, the Next button will be inactive.

o Approval Requirement: By checking the box beside Completely Approved Source, the user is electing
to enforce the requirement that all objects must be fully approved prior to being translated. By leaving this
option unchecked, the user is waiving the requirement that an object be fully approved to be exported for
translation. With this setting unchecked, objects that are partially approved can be exported, but only data
from the approved workspace will be included in a translation export.
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« Include Super Types: In this field, users may click the dropdown to select which super types should be
translated. This field is only activated after a user has selected one of the prime selection methods in the
Selection section above, and then defined a node, file, or collection from which to start the translation. The
super type options are Products (also the default), Classifications, Assets, or All. Because the Excel
translation method does not allow for mixed super types, if the All option is selected, the Excel will be
unavailable as a translation method in a later step (Delivery).

« Include Object Types: In this field, users may select which object types should be included in the
translation export. This field is only activated after a user has selected one of the prime selection methods in
the Selection section above, and then defined a node, file, or collection from which to start the translation. To

specify which object types to include, click the l-=:| button. This brings up a Select Object Types window.

Select Object Types

() All Object Types

(@) Specify |LE'I.|'E|1

Search

I:"'_I‘- LASLOTIUNIUEL FT O LS
(& External Products |
i Packaging Hierarchy
|j Primary Product Classification
E Product Overrides
El|j Products

=17 Levell

0T Level2

&= Details

QK Cancel

« All Object Types is the default selection in the Select Object Types window. If the user wishes to
include all object types included under the super type selected in the previous field, there's nothing to
do in this window. If, however, the user wants to include only a subset of object types in their export,
they may select Specify. This activates the Browse and Search tabs that enable users to select the
object types that should be included. To add the object type the user should first select it in either the
Browse or Search tabs, and then click the right-pointing arrow to bring it into the box where all included
object types are collected. Conversely, to remove object types to be included, select the object type
and then click the left-pointing arrow.

o Ifthe user has opted to translate the objects contained inside a collection, the Include Super Types
field should be set to 'All." If the user wants to include a subset of object types within that collection,

clicking the [:=:/ beside Include Object Types will bring up a Select Object Types window that
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contains the three super types (Products, Classifications, and Assets) from which to select child
objects.

Browse JR=CERG |}

r_=| Alternate Classifications 4
Assets
[#-[IT] Primary Product Classification

- Details

=

o Excluded Attributes: Users can select which attributes to exclude from the translation by clicking the L==
button, which opens the Select Excluded Attributes dialog.

Select Excluded Attnbutes

Search Exduded Attributes

Always Excluded Attributes:
=- £ Attribute Groups ~ 51 DG Attributes

--I'fl Age Group, Maintenance & Care Di Dest Colars

[0 Application Record Attributes Excluded Attributes:
[#-231 Asset Analyzer Attributes []3 pesk sizes

--I'fl Asset Download Attributes
>|'=_=I Business Rules

[#-[(£3 Catalogue Ttem Notification
>|'=_=I Category Spedific Atiributes
#-(£3] DataContainers

--I'fl Data Suffidency Attribute Group
(5] DC_Attributes

--[fl Description1 4

=[5 Desk Materials

. (1T pesk Colors

----- (1T DeskMaterialoptions

QK Cancel
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Users can add or remove language dependent attributes and/or attribute groups from the excluded attributes
list by using the directional arrows located between the Browse/Search and Excluded Attributes
parameters.

o Contextual Attributes: Although language independent, contextual attributes are informative in regards to

the attributes being selected for translation. Users can select contextual attributes by clicking the E button,
which opens the Select Contextual Attributes dialog.

Select Contextual Attributes

[ Browse [[EE Contextual Attributes

~[£ Business Rules A [T country Code
[ Catalogue Ttem Notification (17 size

[0 Category Spedfic Attributes
--Ifl CompMet
E1-E51 DataContainers
-1 Country Code
-1 PM_Model
- [|T PM_Name
(1T PM_shape
|]I Style
|]I Texture
-0 Data Suffidency Attribute Group
-2 DC_Attributes
-3 Description1
[ Desk Materials
-7 Dimensions

epels

S

[ox || cancel |

Users can select contextual attributes for translation inclusion from the Browse or Search tab, and once
selected, click the right directional arrow to place the selected attributes in the Contextual Attributes dialog.
To remove the selected contextual attributes, click the left hand directional arrow.
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Step 4 - Select Target Language

Steps Select Target Language
1. Select Configuration Translate from English
2. Object Selection Select Target Language(s)
5 P & French (fFrenchii
4. select Target Language [] German
z [] Italian
[ ] Russian
[ ] 5panish
e | e

In the Select Target Language step, the user is prompted to select the language they would like to translate their
content into. Click the language or languages that are applicable and click the Next button. At least one language
must be selected to proceed. Itis also possible to click the Finish button, which will begin the export process
immediately, provided there are no errors.
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Step 5 - Feedback

Request Translation - Data Objects

Steps Feedback
1, Select Configuration
2. Object Selection
3. Filter
4, Select Target Language Ohject Type ¥ Total Count » |[Extracted Count » | &
5. Feedback Ttem 62 2
&. Delivery Ttern Folder 7 4
Level 1 22 ]
Material 29 18
Packaging 17 f
Product 114 67
D > [Mame > Reason >
146332 (146332 3 ot approved
145333 (146333) 3C not approved .
| Back || Next || Finish || Cancel |

The Feedback step's primary function is to provide the user with reporting about the objects slated to export so
the user can know what precisely will translate before starting the export. On this screen the user will see listed all
of the objects that will be included in the translation export. The breakdown of this data is captured in two tables.

The first table is the summary of what will be included in the export. This is the data it presents:

« Object Type - The different kinds of object types that will be included in this extraction. In this example, there
is one object type: ItemFamily.

« Total Count - The total count of each object type that will be included in the extraction. In this case, there is
one instance of the ltemFamily object type included in the extraction.

o Extracted Count - The number of each object type that will be included in the translation export.

The second table is a list of all of the objects that will be part of the extraction.

o ID - The STEP ID of the object being translated.
« Name - the STEP name given to the object being translated.

» Reason - The listed reason why it is being included or excluded from the extraction. A green checkmark (
o ) indicates that it will be exported. A red X ( x ) indicates that it will not be exported. Below are some of

the reasons a green checkmark will appear or a red X might appear:
« ¥ Up to Date: objects will not be exported.

« o NotTranslated: objects will be exported for translation.

© Stibo Systems - Confidential - Release 10.1-MP4 (April 20, 2021) 28



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

« 3 Not Approved: objects will not be exported (not applicable if the 'Completely Approved
Source' requirement is unchecked in the Object Selection screen).
« ¥ Notin Approved workspace: objects will not be exported because they are only in the Main

workspace and not the Approved workspace (Regardless of whether the 'Completely Approved
Source' requirement is checked, translation only pulls content from the Approved workspace. If
the object has no data, then the object will not be included in the export).

» 4 Re-translation Needed: objects will be exported for translation.

« 3 In Progress: objects will not be exported because they are already being translated.

« ¥ Invisible in Target: objects are not visible in target language and will not be extracted for
translation.
« ¥ No translation to source: objects will not be exported because the source>target translation

being requested is invalid. For instance, let us say a translation relation exists for an object from
English to French with English set as the Master language. The user then requests a translation
be started from French to English. Because English is set as the master language for the object
being translated, this object cannot be included in a French to English translation, and the 'No
translation to source' status will display for that object.

« X No translatable content: objects will not be exported as there are no values that are language
dependent.

The second table in the Feedback screen will display up to 1,000 items. If there are more than 1,000 items, a row
of text will appear in the second table that reads, 'More than 1,000 objects, only first 1,000 is shown...". To see all
the objects, click the Report button in the upper right corner of the Feedback screen. The objects will then be
exported into a single-column CSV file for review.

For each object listed in the CSV file, there is a + sign (will be included in the export) or a - sign (will not be
included), followed by the reason for why it is or is not included in the export.

This is an example from the CSV file of an object that will not be extracted for translation. Note the minus sign:

Translation Details
ProductObject TypelncludedReasonReferenced
B8723-12 [lﬂﬂﬁld}ltemFamilﬂn Progress-

This is an example from the CSV file of an object that will be extracted for translation. Note the plus sign:

Mens T PBG w Class (179925)ltem-Not Approved-
Mens T PGW (MT18403)Item-MNot Approved-
Cotton T-Shirts (lszm}ltemFamilﬂot Translated-
18216 L O (181951)Item-In Progress-

Mens T PGS (MT18402)Item-Not Approved-

If the user already knows they want the translation data exported as an XML file, they may click Finish. However,
if the user wants an Excel file, or the XML file delivered in a format other than the default (file), they must click the
Next button to manually configure the delivery aspects of their export.
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Step 6 - Delivery

Request Translation - Setup Objects

Steps Delivery
1. Select Configuration Translation Method: | XML “ |
S Filter spreadsheet: ]
3. Filter
4. Select Target Language  Delivery Method: File e
SAREETE Skip Verification: ]
&. Delivery

Delivers exported data in a file. You will be notified when the file is ready for download.

File name template '$ﬁ.léname—ﬁmesﬁmp{ﬁw—rﬁﬁ—da_ﬁH.mm.sé}kexfensiun

Back Mext

1 Cancel .

In the Delivery step, the user specifies whether their content should be exported into an XML or Excel file, and the
method in which that file should be delivered.

Translation Method - From the dropdown, select either XML or the relevant Excel version.

Filter spreadsheet - If either of the Excel versions have been selected from the Translation Method dropdown,
the user may select Filter spreadsheet. This ensures that only the attribute values that require translation are
included in the export (those objects that received the " in the Feedback screen). Objects that do not require

translation (those that received the € in the Feedback screen) are excluded when this option is selected.

Delivery Method - Choose one of options that determine by what method the user will receive the exported
translation file. Dependent on how a user's specific STEP system has been configured, some of these options
may not be available.

The available export options depend on your system setup. The commonly used delivery methods are shown
below (and further defined in the Export Manager - Select Delivery Method topicin the Data Exchange:

« Deploy: Delivers afile to a specified directory.

- Email: Delivers a file as an email attachment. The user must specify the email address of the recipient, a
subject, and the body text.

« File: Delivers afile in the background process. The user is notified when the file is ready for download.

o FTP: Delivers afile using file transfer protocol (FTP). The user must specify the host name, user name,
password, and the file name used to deliver the file.

» Server Side Delivery: Exports the file into a folder located on the Application Server of the STEP system.
The file is only delivered if the specified path has read / write access on the server.
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o SFTP: Delivers afile using the Secure File Transfer Protocol (SFTP). The user must specify the host name,
user name, password, and file name.

« WebSphere Commerce Import: Depends on a user's system setup.

Check the box for Skip Verification if you are certain that all of the objects listed in the Feedback screen are
correct to export. Checking this box prevents suspension of the export process until a user visits the export's
background process and confirms the export may proceed.

File name template - The name the translation file will be saved as; by default, the filename as formatted as
'$filename-$timestamp(yyyy-MM-dd_HH.mm.ss).$extension'.

« $timestamp: This variable is replaced with the time in year-day-month-hour-minutes-seconds-milliseconds,
excluding the dashes. For example, 20161511094709625 is used for an export on 15 NOV 2016 at
9:47:09:625 AM.

Adding a definition for the arrangement of the date / time elements provides a way to generate a more
readable date. Static characters can be included to separate the timestamp elements and individual
elements can be ordered as required, as shown below.

o $timestamp(ddMMyyyy): The timestamp is modified to display day-month-year (excluding dashes) and is
outputas'15112016' for 15 NOV 2016.

o $timestamp(yyyy-MM-dd_HH.mm.ss): The timestamp is modified to display year-month-day
hour.minutes.seconds (including the dashes, underscore, and periods) and is output as '2016-11-15_
09.32.43' for 2016 NOV 15 at 9:32.43 AM.

Saving the data object translation configuration

Once the Request Translation - Data Objects wizard is complete, clicking Finish opens the Save Data Object
Translation Configuration dialog.

[ ! Save Data Object Translation Configuration et
[] Save Options

Save to: | [ConfigurationsExport Configurations, ||:|

(@) Start Translation Process: |Translaﬁng |

() Don't translate now

Ok Cancel

» Save Option: Checking the Save Option checkbox allows the translation configuration to be saved.

« Save to: Clicking the ellipsis button (E) opens the Save to: dialog.
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Search

|'_=| Assets
rj Classifications
[#-[] Configurations

- Details
Asszet to Save Configuration in:

Create Select : Can:él

The translation configuration can be saved to an existing asset (saving to an existing asset will overwrite the
data on the selected asset) or can be saved to a new asset by clicking the Create button and providing a name
for the new asset within the Asset to Save Configuration in: text field and clicking Select.

[ 1 Save Data Object Translation Configuration X
J 9
Save Options
Save to: . JConfigurations/Export Configurations/

(®) Start Translation Process: | Translating

() Don't translate now

oK Cancel

» Start Translation Process: By default, the Start Translation Process text field will be automatially
populated with the word 'Translating'; however, this can be edited by the user.

o Don't Translate Now: Select Don't Translate Now to save the translation for a later time, assuming you
selected the Save Options checkbox. Click OK to close without importing.

For information regarding scheduling a saved translation, see the Scheduling a Data Translation topic.

Reviewing Product Translation Status

When a structured translation export process has been initiated, a few final steps must be taken in that export's
background process.
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Starting process Translating

Starting process "Translating ™ (Translation).
Process started

Gotoprocess  ||[ Close |
| |

To review product translation status:

Click Go to process to go directly to the export's background process.

1.

The translation produces an Excel file listing all of the objects that are included in the export. These listed
objects are the same objects that displayed on the Feedback screen. To view the spreadsheet, click the disk
icon and follow the prompts.

7

Step Query Done

Review outcome of the translation analysis: statusfile_BGP_13500.csv =
Do you want to export these products for translation? [ yes |[ Mo |

A prompt below the report file asks, "Do you want to export these products for translation?" Click Yes to
proceed with the export. Click No to abort the export. If the user has checked the box for Skip Verification on
the Delivery screen, then the export proceeds directly to generating an export file, and there is no question for
the user to answer.

To export the products for translation, click Yes. A zip file is created that contains the data to be translated.

If you click No, the translation export is ended, and the translation status of the selected objects is not changed.

Click the Save icon to save the zipped translation file.
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Structured Translation for Setup Objects

This guidance outlines how to create translation export files for Setup Objects, which refer to LOVs (or List of
Values), attributes, and units. Users who read this guidance should be able to create an export file for these setup
objects, and understand how the content is displayed in the XML export file. For information on translating Data
Objects, see the Starting a Structured Translation documentation.

Before setup objects can be exported for translation, the following criteria must be met:

« Both LOVs and attributes must have a language dimension dependency.
o LOVs must be configured so that the values that comprise them have IDs.
If these criteria are not met, these objects cannot be exported for translation. If these criteria are met, then they can

be exported for translation either by using a Manual Excel Translation export or through creation of an XML file
using the structures translation method.

For more information regarding dimension dependent attributes, see the Dimension Dependent Attributes
topicin the System Setup documentation.

For more information regarding IDs for LOVs, see the Creating an LOV topic in the System Setup
documentation.

Generating Translation Export Files for Setup Objects

The process required to initiate translation exports for setup objects is not significantly different from the process
for data objects. With that in mind, listed below are the differences to consider when initiating translations for setup
objects that make the process different from that of data objects.

Exporting to XML
1. Ensure that the context is set on the correct source language context.
2. From the File menu, click Translate, and then select Setup Objects.

File I Edit View Mavigate Format Maintain Window Help

Translate b Data Objects...

Import ] Setup Objects...

Export ] Manual Excel Translation Export
@‘: Reports ﬁ Import Translation...

Bulk Update b Change Translation

Schedule Category Profiling Schedule Data Translation...

The Request Translation - Setup Objects wizard guides the user through the six steps that enable the user to
adapt the translation export to their specific requirements.
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Step 1 - Select Configuration

Request Translation - Setup Objects

Steps Select Configuration

1. Select Configuration

2. Object Selection
3. Filter (O Use Existing Translation Configuration

4. Select Target Language @ Treate New Transiation Confiquration
5. Feedback

6. Delvery

Back MNext Finish Cancel

The first step in the Request Translation - Setup Objects wizard is Select Configuration. With the
appropriate radio button selected, the user can select an existing translation configuration by clicking the ellipsis
button (|...) and selecting the desired configuration, or create a new translation configuration.

Step 2 - Object Selection

Request Translation - Setup Objects

Steps Object Selection
1. Select Configuration ~ Selection
2. O bject Selection ® From Root Node
3. Filter Root Node

4. Select Target Language i_) From Collection

5. Feedback Collection
6. Delvery Refresh Automatically
Back Mext Finish : Cancel

The second step in the Request Translation - Setup Objects wizard is Object Selection. In this step, the user
selects which objects should be included in the translation export, and from where in STEP the objects should be
pulled.

There are two ways to select objects.
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~ Selection
@ From Root Node

Root Node
) From Caollection

Collection

Refresh Automatically

« From Root Node: For importing objects directly from the Tree. If the user has started the Request
Translation - Setup Objects wizard while standing on an object in the Tree, that object will pre-populate

the Root Node field. If the user wishes to change the selection, clicking the l===/ button will bring up a screen
allowing the user to either Browse the Tree for the object, or Search for the object by typing the sought-for
object directly into the search field.

o From Collection: For importing a manually selected grouping of various object types (which can,

potentially, be from multiple super types) grouped in a collection. In the Collection field, click the [-=-| button
and either browse or search for the collection to be translated. If the collection is based on a search and you
want to ensure that new or amended values in the collection are captured prior to exporting for translation,
click the box beside Refresh Automatically.

Step 3 - Filter

Request Translation - Setup Objects

Steps Filter

1. Select Configuration ~ Fitter Options
2. Object Selection Include Not Translated Re-Translation Needed
3. Filter

4. Select Target Language
5. Feedback

6. Delvery

Back || Mext Finish Cancel

The third step in the Request Translation - Setup Objects wizard is Filter. In this step, the user may elect to
include or exclude values that are Not Translated or values that have been amended and are thus designated as
Re-Translation Needed. Click the boxes next to each to include them in the filter. One or both must be checked
to proceed. Otherwise, the Next button will be inactive.

© Stibo Systems - Confidential - Release 10.1-MP4 (April 20, 2021) 36



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Step 4 - Select Target Language

Request Translztion - Setup Objects

Steps Select Target Language
1. Select Configuration Translate from English
2. Object Selection Select Target Language(s)
3. Fiter French ([French]} 8
4. Select Target Language [] German
5. Feedback
[] Italian
6. Delvery
[ Russian v
Back Mext Finish Cancel

In the Select Target Language step, the user is prompted to select the language they would like to translate their
content into. Click the language or languages that are applicable and click the Next button. At least one language
must be selected to proceed. Itis also possible to click the Finish button, which will begin the export process
immediately, provided there are no errors.

Step 5 - Feedback

Request Translation - Setup Objects

Steps Feedback
1. Select Configuration
2, Object Selection
3. Filter
4, 5elect Target Language Ohject Type » Total Count » |[Extracted Count » | &
5. Feedback Ttem 52 ]
&. Delivery Ttem Folder 7 4
Level 1 22 ]
Material 29 18
Packaging 17 ]
Product 114 a7
D > |Mame * |Reason >
146332 (146332) 3 Mot approved
145333 (146333) 3€ niot approved -
| Back || Next || Fnish || Cancel |
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The Feedback step's primary function is to provide the user with reporting about the objects slated to export so
the user can know what precisely will translate before starting the export. On this screen the user will see listed all
of the objects that will be included in the translation export. The breakdown of this data is captured in two tables.

The first table is the summary of what will be included in the export. This is the data it presents:

« Object Type - The different kinds of object types that will be included in this extraction. In this example, there
is one object type: ItemFamily.

« Total Count - The total count of each object type that will be included in the extraction. In this case, there is
one instance of the ltemFamily object type included in the extraction.

« Extracted Count - The number of each object type that will be included in the translation export.

The second table is a list of all of the objects that will be part of the extraction.

o ID - The STEP ID of the object being translated.
o Name - the STEP name given to the object being translated.

« Reason - The listed reason why it is being included or excluded from the extraction. A green checkmark (
o )indicates that it will be exported. Ared X ( 3¢ ) indicates that it will not be exported. Below are some of

the reasons a green checkmark will appear or a red X might appear:

X Up to Date: objects will not be exported.
o Not Translated: objects will be exported for translation.

3 Not Approved: objects will not be exported (not applicable if the 'Completely Approved
Source' requirement is unchecked in the Object Selection screen).
X Not in Approved workspace: objects will not be exported because they are only in the Main

workspace and not the Approved workspace (Regardless of whether the 'Completely Approved
Source' requirement is checked, translation only pulls content from the Approved workspace. If
the object has no data, then the object will not be included in the export).

o Re-translation Needed: objects will be exported for translation.

X In Progress: objects will not be exported because they are already being translated

X Invisible in Target: objects are not visible in target language and will not be extracted for
translation.
X No translation to source: objects will not be exported because the source>target translation

being requested is invalid. For instance, let us say a translation relation exists for an object from
English to French with English set as the Master language. The user then requests a translation
be started from French to English. Because English is set as the master language for the object
being translated, this object cannot be included in a French to English translation, and the 'No
translation to source' status will display for that object.

X No translatable content: objects will not be exported as there are no values that are language
dependent.

The second table in the Feedback screen will display up to 1,000 items. If there are more than 1,000 items, a row
of text will appear in the second table that reads, 'More than 1,000 objects, only first 1,000 is shown...". To see all
the objects, click the Report button in the upper right corner of the Feedback screen. The objects will then be
exported into a single-column CSV file for review.
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For each object listed in the CSV file, there is a + sign (will be included in the export) or a - sign (will not be
included), followed by the reason for why it is or is not included in the export.

This is an example from the CSV file of an object that will not be extracted for translation. Note the minus sign:

Translation Details
ProductObject TypelncludedReasonReferenced
88723-12 [lﬂﬂﬁld}ltemFamilﬂn Progress-

This is an example from the CSV file of an object that will be extracted for translation. Note the plus sign:

Mens T PBG w Class {179925)ltem-Not Approved-
Mens T PGW [MT18403) Item-Not Approved-
Cotton T-Shirts {IEZGE}ItemFamillﬂmt Translated-
18216 L O (181951)Item-In Progress-

Mens T PGS (MT18402)Item-Not Approved-

If the user already knows they want the translation data exported as an XML file, they may click Finish. However,
if the user wants an Excel file, or the XML file delivered in a format other than the default (file), they must click the
Next button to manually configure the delivery aspects of their export.

Step 6 - Delivery

Request Translation - Setup Objects

Steps Delivery
1, Select Configuration Translation Method: | ¥ML w |
i Filter spreadsheet: E
3. Filber
4. Select Target Language  Delivery Method: File e
5. Feedback Skip Verification: ]
6. Delivery

Delivers exported data in a file. You wil be notified when the file is ready for download.

File name template '$ﬁ.|n:=-_name—ﬁmesﬁmp{ﬁw—f&ﬁ—da;HH.mm.ss.}-.$ext.ensiun

Back Mext

Cancel

In the Delivery step, the user specifies whether their content should be exported into an XML or Excel file, and the
method in which that file should be delivered.

Translation Method - From the dropdown, select either XML or the relevant Excel version
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Filter spreadsheet - If either of the Excel versions have been selected from the Translation Method dropdown,
the user may select Filter spreadsheet. This ensures that only the attribute values that require translation are
included in the export (those objects that received the " in the Feedback screen). Objects that do not require

translation (those that received the € in the Feedback screen) are excluded when this option is selected.

Delivery Method - Choose one of options that determine by what method the user will receive the exported
translation file. Dependent on how a user's specific STEP system has been configured, some of these options
may not be available.

The available export options depend on your system setup. The commonly used delivery methods are shown
below (and further defined in the Export Manager - Select Delivery Method topic in the Data Exchange:

» Deploy: Delivers afile to a specified directory.

« Email: Delivers a file as an email attachment. The user must specify the email address of the recipient,
a subject, and the body text.

« File: Delivers afile in the background process. The user is notified when the file is ready for download.

o FTP: Delivers afile using file transfer protocol (FTP). The user must specify the host name, user name,
password, and the file name used to deliver the file.

« Server Side Delivery: Exports the file into a folder located on the Application Server of the
STEP system. The file is only delivered if the specified path has read / write access on the server.

o SFTP: Delivers afile using the Secure File Transfer Protocol (SFTP). The user must specify the host
name, user name, password, and file name.

« WebSphere Commerce Import: Depends on a user's system setup

Check the box for Skip Verification if you are certain that all of the objects listed in the Feedback screen are
correct to export. Checking this box prevents suspension of the export process until a user visits the export's
background process and confirms the export may proceed.

File name template - The name the translation file will be saved as; by default, the filename as formatted as
'$filename-$timestamp(yyyy-MM-dd_HH.mm.ss).$extension'.

« $timestamp: This variable is replaced with the time in year-day-month-hour-minutes-seconds-milliseconds,
excluding the dashes. For example, 20161511094709625 is used for an export on 15 NOV 2016 at
9:47:09:625 AM.

Adding a definition for the arrangement of the date / time elements provides a way to generate a more
readable date. Static characters can be included to separate the timestamp elements and individual
elements can be ordered as required, as shown below.

o $timestamp(ddMMyyyy): The timestamp is modified to display day-month-year (excluding dashes)
and is outputas '15112016' for 15 NOV 2016.

o $timestamp(yyyy-MM-dd_HH.mm.ss): The timestamp is modified to display year-month-day
hour.minutes.seconds (including the dashes, underscore, and periods) and is output as '2016-11-15_
09.32.43' for 2016 NOV 15 at 9:32.43 AM.
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Saving the setup object translation configuration

Once the Request Translation Wizard is complete, clicking Finish opens the Save Data Object Translation
Configuration dialog.

setup Object Translation Configuration

Save Options

Save to: | [Configurations/ |

(@) Start Translation Process: |Translaﬁng |

() Don't translate now

[ o || candl |

« Save Option: Checking the Save Options checkbox allows the translation configuration to be saved.

« Save to: Clicking the ellipsis button (E) opens the Save to: dialog.

Browse [EEG)

|j Assets
|j Classifications
[#-[T] Configurations

©petals
Asset to Save Configuration in: |:|
[‘.rea.te Select Cancel

The translation configuration can be saved to an existing asset (saving to an existing asset will overwrite the
data on the selected asset) or can be saved to a new asset by providing a name for the new asset within the
Asset to Save Configuration in: text field and clicking the Create button.

» Start Translation Process: By default, the Start Translation Process text field will be automatially
populated with the word 'Translating'; however, this can be edited by the user.

o Don't Translate Now: Select Don't Translate Now to save the translation for a later time, assuming you
selected the Save Options checkbox. Click OK to close without importing.

For information regarding scheduling a saved translation, see the Scheduling a Data Translation topic.
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XML Export of Setup Data

LOV

Displayed below is an example of a LOV and its three component values exported for translation. In this case, the
LOV name is Colors, the target language is German, and the values (highlighted in yellow) are Yellow, Green,
and Red. In this instance, these values are to be translated into German.

<STEP-ProductInformationTranslation ExportTime="2013-03-27 10:06:21"
ExportContext="EN All Al1l" ContextID="EN All All"

WorkspaceID="Main" wfmProcessTemplateName="Translation"

wfmProcessID="BGP 768298" translationTarget="German"
PendingFileName="translation.xml">

<ListsOfValues>

<ListOfValue ID="Colors" UseValuelID="true"
AllowUserValueAddition="false" ParentID="List Of Values group root">

<Name>Colors</Name>

<Validation InputMask="" MaxLength="100" MaxValue="" MinValue=""
BaseType="text"/>

<DimensionLink DimensionID="Language"/>

<Value ID="634592"
QualifierID="en"><TranslatableText>Yellow</TranslatableText></Value>

<Value ID="634593"
QualifierID="en"><TranslatableText>Green</TranslatableText></Value>

<Value ID="634594"
QualifierID="en"><TranslatableText>Red</TranslatableText></Value>

</ListOfValue>
</ListsOfValues>
</STEP-ProductInformation>

Next, a translation vendor would receive this data, translate the data, and then send the updated XML file with the
translated values back to the user. Subject to how the workflow has been configured between the user and the
translation vendor, the updated XML file is then imported back into STEP, and the translation of the setup data is
complete.

Attribute Name

Displayed below is an example of an attribute name and an attribute metadata value exported for translation (the
text to be translated is highlighted in yellow). In this case, the attribute name is Color Attribute, and the metadata
attribute is Description, for which the value is "This color attribute is supposed to be used for cars.'

<STEP-ProductInformationTranslation ExportTime="2013-03-27 10:06:21"
ExportContext="EN All All" ContextID="EN All AI1l"

WorkspaceID="Main" wfmProcessTemplateName="Translation"
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wfmProcessID="BGP 768299" translationTarget="German"
PendingFileName="translation.xml">

<AttributeList>

<Attribute ID="Color" MultiValued="false" ProductMode="Property"
FullTextIndexed="false" ExternallyMaintained="true"

Derived="false" HierarchicalFiltering="false" Selected="true"
Referenced="true">

<Name><TranslatableText>Color Attribute</TranslatableText></Name>
<ListOfValueLink ListOfValueID="Colorsl"/>

<DimensionLink DimensionID="Language"/>

<MetaData>

<Value AttributeID="Description"><TranslatableText>This color attribute

is
supposed to be used for cars</TranslatableText></Value>
</MetaData>
<AttributeGrouplLink AttributeGroupID="AAKAl"/>
<UserTypelink UserTypelID="Product"/>
<UserTypelLink UserTypeID="LATS TEST OT"/>
</Attribute>
</Attributelist>

</STEP-ProductInformation>

As with the LOV example, a translation vendor would receive this attribute name data, translate it, and then send
the updated XML file with the translated values back to user. Subject to how the workflow has been configured
between the user and the translation vendor, the updated XML file would then be imported back into STEP. The
translation of the setup data is then complete.
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Starting a Manual Excel Translation Export

This guide covers how to generate a Manual Excel Translation Export, which is the translation export method best
used when users need to send a very limited amount of content to a vendor for translation, or when exporting
Setup Objects into an Excel file when XML is not a suitable option.

In most cases, creating an Excel translation file through the structured translation process (File > Translate > Data
Objects) is the correct method when an Excel translation export file is required. The Manual Excel Translation
Export method is best used in a limited number of use cases.

Manual Excel Translation Export is a translation method best suited for instances when:

« thereis an extremely limited amount of content to translate

« the translator does not have access to either STEP or a third-party translation tool
« the objects to be translated are setup objects (attribute names, LOVs, and units)

Often, the Manual Excel Translation Export process is used in coordination with the translation vendor to correct
an error or process a late addition. Because this translation method represents the most straightforward way to
export a limited number of objects into a single target language, it is considered a good route to efficiently handle

small issues that arise following shipment of a larger translation file.
To Export an Excel File Manually for Translation

To create a Manual Excel Translation Export, open the File menu, point to Translate, and then click Manual
Excel Translation Export.

doc-trunk - userk@https://doc-trunk.stibo.com - 5TEPworkbench

File | Edit View Mavigate Format Maintain Window Help

3 Data Objects...
Import | b Setup Objects...
Export ] I Manual Excel Translation Export I
P Reports P Import Translation...
Bulk Update ] Change Translation
Schedule Category Profiling @ Schedule Data Translation...

The Excel Translation Export wizard displays.
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Step 1 - Select Objects

Excel Translation Export

Steps Select Objects
1. Select Objects D > [Name > [ObjectType >
2. Select Language > | Aad Object(s)
3. 5elect Format
[ ] Recursive
Back Mext Finish i .C-an::el i

In the Select Objects step, the user may select which objects should be included in the Excel translation file being
generated.

If an object has already been selected when initiating the Excel Translation Export, that object will appear pre-
populated as one of the objects in this list. If the object is included in error, be sure to remove it by right-clicking the
object and then selecting Remove Object from the list of options that appear.

1. Click the blue-shaded Add Object(s) text and then, in the Select Additional Nodes for Excel Translation
window that displays, use either the Browse or Search functions to locate and select the objects you want to

translate.

Select Additional Modes for EBxcel Translation

-El'uwse | Search |

| || Search

& advanced

[ MName

Select Cancel .

2. Additionally, be sure to add a check to the checkbox beside Recursive if all objects that are 'children’ to the
selected 'parent’ object should also be included in the Excel translation export.
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Excel Translation Export

Steps Select Objects
1. Select Objects D » |Name » |ObjectType »
2. Select Language > | Add Object(s)
3. Select Format
[]Recursive
Back Mext Finish Cancel

Step 2 - Select Language

The Manual Excel Translation Export allows for one language to be targeted for each export file produced. The
Select Language step allows the user to choose either a source language or a target language as the language

they export the Excel to translate into.

Excel Translation Export

Steps Select Language
1. Select Objects The language for the selected object(s) is All Languages
2. select Language Select a Source or a Target Language for translation.
3. Select Format () Source Language  |All Languages
(@) Target Language :FfEI'ICh —
Back Mext Finizh Cancel

The first line of text in this window (‘The language for the...") informs the user what the source language for the
selected object is. This is determined entirely by what context STEP is set to at that moment. In most cases, the
source language will be correctly set based on the context, and only the target language will need to be chosen.
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However, if the user decides to select Source Language and then select a language different from the context
language, the language appearing in the Target Language field will revert from whatever it's set on to the
context-driven source language. As an example, if the context is set to English, but a user changes the source via
the Source Language field to French, the Target Language value will automatically change to English. In effect,
it is not possible to set both the source and target to a language that is not set by the context.

Step 3 - Select Format

In the final step in the Manual Excel Translation Export, the user selects which kind of Excel document the data
should be exported into.

Excel Translation Export

Steps Select Format
1. Select Objects
2. Select Language
3. Select Format Export Format Excel 97/2003 w
Back |  lext | Cancel

Click the Export Format dropdown list and select the relevant Excel format. The choice is between Excel
documents from the Microsoft Office 97, XP, 2003 versions, or Excel 97 and beyond. It is recommended that users
use the newest, supportable versions of Excel. File errors may occur during different STEP processes if using a
template set to an older Excel version.

Then click Finish.

A Save window will appear prompting the user to select the location where the Excel document should be saved.
When you have selected the destination location and clicked Save, the export completes, and the exported Excel
document will be available.

The Excel file you exported will look something like this:
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A, B C

1 |This sheet is a Stibo Systems translation excel sheet. Please do not change the structure of the sheet.

2

3 Product: Cotton T-Shirts

4 Source: English Target: French
5 ID 18209 18209

6 Name Cotton T-Shirts Cotton T-Shirts
[ value a value a

g Attribute A, Country Root [text] value b value b

9 value ¢ value ¢

10 | Brand Owner [text{100)] HanesBrands HanesBrands
11 | Secondary Color [text{100)] Red Rouge

12 Country of Origin [text(100]] CHIMNA CHINA

The Hanes Beefy-T T-Shirt For over 35 years, it has set
. . the standard for T-shirt comfort and quality. Today it's
Family Description [text(2000)] better than ever, offering greater durability and less

13 shrinkage than you'll get with ordinary tees.

14 1S0ODate [isodate] 2014-05-04 2014-05-04

15 Lead Time [integer] 2 dy 2 (unece_unit. DAY)
16 Manufacturer Name [text{100}] HanesBrands HanesBrands
17 Manufacturer Warranty [text{200)] & months on workmanship and materials

18 Brand Name [text{100)] Hanes Hanes

19 Material [text(100]] Yahoo
20 Product Name [text(10000)] abc MName 1
21 Selling Unit of Measure [text{100)] EA EA
22 Selling Unit of Measure Qty [integer] "
23 Provider GLN [text{100)] 1234567891234 1234567891234

The translation work can be done directly in the Excel file and then imported back into STEP.

Important: Special characters like the greater-than and less-than symbols (> and <, respectively), double and
single quotes, or the double prime (to denote lengths measured in inches), must be mapped in STEP prior to
exporting an Excel file using this method. If this is not done, the file will error on import.

For more information on manually translating content in an Excel file, see the Manually Translating XML and Excel
Files documentation. For information related to importing translation Excel files, see the Importing Translation
Excel Files documentation.
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Manual Translation

This topic covers the third method of translation content in the system, manual translation. This topic covers how
a user can translate content in the workbench by adding content directly into the attribute for the target language.

Manual translation is only appropriate when two criteria have been met:

« translators are given direct access to the system
» the amount of content to be translated is not substantial

If either of these criteria are not met, the structured translation process is likely to be a better option.

As an example of an instance where manual translation might be a good option, Company Z sells t-shirts. All of
their product information is translated and up to date. Marketing sends a directive that a word used in the product
description for one t-shirt brand needs to be changed for the US and all other global markets. As this work is very
limited in scope, manual translation can be a viable and potentially fast method to approach this challenge. In this
example, the user would access the product in question, visit each language for that product, and update the
relevant description for each.

Executing a Manual Translation
1. Findthe objectin the Tree. In this example, the product to have attribute values translated is 18210 M B.

| | Context |English US

|‘='_=‘| ETIM Artide Groups
-] GPC_Root

--@ Index Words
=-7) Primary Product Hierarchy

=T Products
Elr_=| Apparel
E}|‘_=| Upper Body Wear
-5 T-shirts
=t-Jjili T-shirts Items
.E 12-GGKT9
L 135442 . 12-GGK79

ﬁ Ay New Product

=i Cotton T-Shirts

----- E Mew Product 1234

[ STEP Worlflow " Bookmarks
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2. Select the target language you would like to view from the Context dropdown. If, for instance, the user wants
to make a change to the French translation of an attribute, they would select the French FR language from this

dropdown.

File Edit View Mawvigate Format Maintain '

Context |French FR.

French FR.
English Us
-2 {dlsrael Hebrew
G- (gDanish DK
-5 (HEnglish UK
r_=| AFrench Belgium

BT3¢ French Canada
.7 efGErmany German

[ »

m

3. Clickon Translation Mode. Translation mode displays an object as it exists in two languages, typically the
source and the target. Clicking on Translation Mode will display the target language you chose via the Context,
and the source language will display, by default, as English.

File Edit View MNavigate Format Maintain Window Help

[T context |Engish us ~ | C URL |'editor=1009148workspaceid=Main 3 [ Goto [1miname o

4. When you switch to Translation Mode, you may receive an instruction dialog that reads like this:

@ Flease select source language

If you see this, follow step four (below), and select the desired source language. Your system will remember
this selection and display it as the source language in Translation Mode until it is changed or the system cache

is cleared.

5. To select or change the source language, click View in the File menu, and then Source. In the dropdown that
displays, all available languages that have been designated on your system as either a source or a target will
be listed. Select the relevant source language from these.
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In this example, we have French displaying as the target language on the Product Translation tab (notice the
French FR displaying in the Context field), and Approved UK English as the source language. The 'Approved'
in ‘Approved UK English' references the fact that content to be translated, whether manually or through a

structured export, comes from the approved workspace. Attributes that require translation are shaded green.

In this screenshot, the Long Description attribute is shaded green and has a value in the Approved UK English
column but none in the French column. The green shading is the user's prompt to add a translated value for
that attribute. In this example, the attribute needs a French language value.

[ context [FrenchR | ¥ € > C URL [Englishieditor=Transiations| =] [] (2! ] [l Goto [1oiheme
o { 18210 M B rev.0.25 - Product Translation
z g Primary Product Hierarchy ~ References || Referenced By || Tables
il I |'_=| Products
§| | B0 Apparel '
oi| 5| F I3 Upper Body Wear > » |Approved UK English French
| o E-IR T-shirts > |AttrbuteY A
—T - Prcrdluct Linking Test > | |Attribute Z
o =l T-shits [tems > | AttWithLangDepLOV
i CEseTBA2 > | |Avaiabilty End 20151001 11:41:37 2015-10-01 11:41:37
@ E‘Et;‘;;:f"h':s » | Backplate Diameter (Cm)
EI ﬁ LI LE » Backplate Diameter (In}
v ﬁ 1821311 0 » wner HirLesElr:rr‘]ds -~ HanesBrands
N 121610 2 e pesrpton v " S e
% E Mens T PBO 38 Capaciy
@ 8 Mens T PBG > | lcost 6355 6.35 §
E ™ Mens T PGS » | ICost Effective Date 2014-12-16 00:00:01 2014-12-16 00:00:01
% | Mens T PGW > Cost Expiation Date  2016-12-16 13:41:02 2016-12-16 13:41:02
] -8 Mens T POY » | Couleur Primaire Gray Noir
0 -8 Mens T PBO » | ICouleur Secondaire Red Rouge
El | Mens T PBG > | |Country of Origin CHINA CHINA
= - Mens T PGS o |[> | Description, Web v
5 R W T DA
| € » £ >
Ready |
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7. Toadd a value, the user must click into the value cell for the appropriate attribute under the green-shaded
target language column, and then type or paste in the translated value.

18210 M B rev.0.25 - Product Translation

N Primary Product Hierarchy GG TR [EGE RGN | References || Referenced By || Tables

S 03 Products
o
E E—Ji Upper Eody Wear > > |Approved UK English * |French ?
il E'i T-shirts » | |Attribute N ~
= [l Product Linking Test >|  |AttrbuteY
) =l T-shirts Items > | |attribute 7
7 -l 8872312 > | AttwithLangDepLOV
g =il Cotton T-Shirts > | |Avaiability End 2015-10-01 11:41:37 2015-10-01 11:41:37
% E ﬁ > Backplate Diameter (Cm)

o > Backplate Diameter (In}

2 -\ 18213 M0 > | Pend e _HanecRrands HanesRrands

] ™ 18216 L O T-shirt, short sleeve, T-shirt, manches
% ™ Mens T PBO > [] Bréve Description Article Beefy-T, Mens M, Royal  |courtes, Beefy-T,

& ™ Mens T PBG Blue Hommes M, bleu royal
E ™ Mens T PGS - 1y
T, -\ Mens T PGW > | lcost 635§ 6.35 %

; E Mens T POY » Cost Effective Date 2014-12-16 00:00:01 2014-12-16 00:00:01
“ E Mens T PBO » Cost Expiration Date 2016-12-16 13:41:02 2016-12-16 13:41:02
T - Mens T PBG > | (Couleur Primaire Gray Noir
ED -\ Mens T PGS * | |Couleur Secondaire Red Rouge
g -8 Mens T PGW > | (Country of Origin CHINA CHINA

= |8 Mens T POY > | Description, Web

In this way, most translatable data can be added for all language dependent attributes in all languages. However,
because each language dependent attribute must be amended for each language manually, manual translation is
not recommended for any translation except those with a very limited amount of content to translate.
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Manually Translating XML and Excel Files

This topic provides a detailed description of how to go into a STEP-exported Excel or XML translation file and add
the translated values directly to the file. The files referenced in this documentation are generated through the
structured translation process (Excel or XML), or the Manual Excel Translation Export (Excel). This process is
different from manual translation in that the work is being done to an exported file rather than directly in STEP. To
review the steps required to generate a translation export file through the structured translation process, see the
Starting a Structured Translation documentation.

When the translation export has been generated (through either the structured translations process or the Manual
Excel Translation Export), the background process will stop at 50% complete.
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181951, en-US > Danish - Background Process

: [ockground Process [[eery
i e :5 MountDocForPlan + || Properties -
-_EE [+ ;;’j MultipleRevive Property » [Value >
EI [+ ]';j ModeListToCollection Started by LUSERB
[+ }';j PCF of planned page » ——
- [+ ]';j PageDone — - .
“: [+#] ]b Pre-generate thumbnail cache Description 181951, en-JS = Danish
E [ ]b Publication Duplication Execution Server doc-dev
EI [+ lgj Purge Dimension Point —
o e ];’j Purge Matching Data Statis SUspended
e L ,3:, Purge Revisions Created Mon Aug 08 15:58:21 EDT 2016
# ];j RuleSetExporter & Execution Report
i et o= |
E; 333 SuspendBGPs ® Mode selection list was specified. Will automatically accept analysis result
& :ngDTAFCunuert 7 Parsedtranslation configuration
E-£5 Translation (2) * Logged on
% Queued Processes ° Updating translation status
E}% Active Processes (1) 101 nodes will be exported for translation
%‘% 18202, en-U5 > Hebrew 1 Merging table data
%,’é 157617, enUs > fr i Exported nodes
,gjég. |1aj_q5L ens = w| 1% Translation Export Completed
ﬁ% 135833, en-US = fr 12 Delivery started (Mon Aug 08 15:58:23 EDT 2016)
--48% 110611, en-US > fr 20 Delivery completed (Mon Aug 08 15:58:23 EDT 2016)
E}-% Ended Processes (1)
=l i 3
5 4 e o roes « [ Jsmon[® ][ »
m-£85 Unlink Object Type
[ :33 Update actual page from plan ' Result
[ ;b UploadDTPDocument Step WVait for Translation
& ]b Vieh UL Asset Fipeine Downdoad B8 Review outcome of the translation analysis: statusfile_BGP_182235.csv
[+- &5 Web UI Download -
< m | b Exported translation files: xmitranslation_BGP_182235.7ip

The Progress bar showing at 50% means the export portion of the translation task is complete, but the translation
task itself is paused until the updated file, with all of the translated values added, is imported. The export generates

a zip file that contains the data, in either an Excel or XML format, to be translated. Typically, this file is sentonto a
translation vendor that does the translation work. In some instances, particularly when there are very few objects

that require translation, it may make sense to translate directly within the exported file rather than sendingitto a

third party.

At the bottom of the background process is a row called Exported translation files. To the right of that is a disk
icon (!&l). Clicking the icon will allow the user to access the export file.
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Translating in an Excel File

The Excel file features a color-coded cell format that quickly alerts the user to each element's status. Below is a
sample of what a user might find in an exported Excel file:

_lo/x
A B | C =
Product: Battery 3638

3

4 Source: English Target: German
5 1D Battery 3635 Battery 3635

E |[Name Battery 3638 Battery 3638

7 |Text attribute Jtext{ Thiz battery can last forever

8 |Attribute 1 [text{110i

9 |Key words [text{500

10

11 Product: Battery 4242

12 Source: English Target: German
13 1D Battery 4242 Battery 4242

14 [Name Battery 4242 Battery 4242

15 [Text attribute [text{ This battery cannot last for ever and ever
16 [Attribute 1 [text(110 =
17 |Key words Jtext{500

18

4
M 4 ¢ M[%Translation sheet / | ] I LI =

There are only four cell-shading colors a user may encounter in an Excel export file:

Background color Description

Blue The product name

Green Product information to be translated

Yellow Product information that does not need translation

White Product information that has already been translated and approved

The only cells where the user should take action are those that are color-coded green.

To translate directly in the Excel export file, click into the green-colored cell in the target language column, and
insert the translated value of the corresponding value appearing in the source language column. Below is an
example of how this will look when completed for one product and one target language:
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14 Product: Battery Backup

15 Source: English Target: German

16 1D 157617 157617

17 Name Battery Backup Battery Backup

18 Manufacturer Name Rise-N-5Shine Rise-N-5Shine

19 New Product [text(1Yes Yes

20 Sales ltem Short Des Never miss a wake-up call | verpassen Sie nie einen Weckruf |

When translated values have been added for all of the blank green-colored cells in the target language columns,
the user should save the file, remembering to retain the Excel file extension. The file name can be whatever the
user prefers; STEP keys on the ID information inside the Excel, so the file name has no impact on the translation
process. The file is now ready to be imported.

For more information on importing Excel translation files, consult the Importing Translation Excel Files
documentation.

Translating in an XML File

If the user has elected to export an XML file through the structured translation process, the zip file is accessible via
the disk icon ([&] ) at the bottom of the background process.

The zipped XML translation export file contains these files:

File Description

preview.css Contains style preview information.

preview.xsl Contains style sheet information for displaying translatable content.

preview.tags Contains tag information.

translation.xml | Contains data to be translated. You can translate directly in the XML file. All fields that can be
translated are tagged
<TranslatableText>.

The file where the manual translation work will be done is in the translation.xml file.

To translate directly in the XML export file, the user replaces the source language content that appears between
the <TranslatableText> tags in the XML file. In the screenshot below, you will find yellow-highlighted text
appearing between two red-boxed <TranslatableText> tags. The text highlighted in yellow is what the user
would replace with the translated value.
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D||||I|||1|D||||I||| 2|EI||||I|||3|D||||I|||'I1|D||||I||| 5|D||||I|||6|D||||I||| ?lullllllTlBlnllllllllglnl|||I|||1DD|||I|||13D|||I|||1£w| 11
! <fQualifiersy
&5 <Products>
&a[- <Product ID="181951" UserTypell="Iten" ParentID="12209":
&7 <Name QualifierID="ztd.lang.all":
88 | <TranzslatableText>18216 L 0</TranslatableTexty</Name>
83[F] <Value AttributeID="URL" QualifierID="en-U5">
84 ¢TranslatableText>http://www.google.con</TranslatableText>
BS | </Value></MultiValuey<Value AttributeID="CostEffectiveDate" AttributeName=" (CostEffectiveDat:01</Value><Value Atttiar
1 ¢TranslatableText>T-shirt, short sleeve, Beefy-T, Mens L, Orange</TranslatableText>
87 | </Value»<Value AttributeIl="AvailabilityEnd" AttributeName="(AvailabilityEnd)">2015-10-01 11:4ttributell="LongltemlrIl-
B anes Beefy-T short sleeve T-shirt in 100% cotton that resists shrinkage.
gy L </Values<Value AttributeIl="IsInvoiceUnit" ID="Y">¥</Value><Value AttkibuteIE="ListPrice" Unit" AttributeName=" (Liz:><}
50 </Producty

a1 </Productsy
32  </STEP-ProductInformationTranslations

When translated values have replaced all relevant content tagged with <TranslatableText>, the user should save
the file, remembering to retain the XML file extension. As with the Excel file, the file name can be whatever the
user prefers; STEP keys on the ID information inside the XML, so the file name has no impact on the translation
process. The file is now ready to be imported.

For more information on importing XML translation files, consult the Importing Translation XML Files
documentation.
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Asynchronous Translation

Asynchronous translation is a STEP feature that enables customers to configure automated transmission and
receipt of translatable and translated content via a REST API. This method of translating content does not add or
subtract any translation capabilities to or from STEP, but rather facilitates existing translation processes.

For more information on asynchronous translation, see the Asynchronous Translations section of the Data
Integration documentation.
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This topic will cover the process of importing a translation XML file into STEP.
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Once the translation vendor has completed translation of the submitted objects in an XML file, the XML file can be
imported into STEP. Importing a translation XML file into STEP will bring all of the new translated values into the

appropriate language contexts.

After the user has initiated an import, but before the import is executed by the system, STEP takes a series of
automated steps to ensure the translated content is handled correctly. Prior to executing an import STEP will:

« Checkthatthe XML is valid (not malformed)

« Check that no values in either the source or target language have been modified in STEP since the XML file

was exported

« Checkthat the imported values match the attribute validation base types in STEP (for instance, if an attribute
restricted to accept only number values is given a free text value, an error is raised)

To start the translation Import Wizard, click File > Translate > Import Translation...

|Fi[e‘Edit View Mavigate Format Maintain Window Help

e )

Import
Export

#° Reports
Bulk Update

Schedule Category Profiling

¥

¥

>

b

e
Elych

Data Objects...
Setup Objects...

Manual Excel Translation Export

Import Translation...

Change Translation

Schedule Data Translation...
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Step 1 - Select file

Translation lmport

Steps Select Fie
1. Select File C:\WUsers\Documents Translation Files for Import'xmitranslation_BGP_181287.zip
2, Import Options
Lok in: Translation Files for Import ~ T il

I xmltranslation_BGP_181287 zip

File name: .xmltranslaﬁon_EGP_lalzﬁ?.zip

Files of type: Zip Files (*.zip), ¥ML Files (*.xml) and Excel Files (*.xs and *.xslx) -~ .

Back Mext - Finish Cancel

In the Select File step of the Translation Import Wizard, the user must select the XML file they wish to import. To
select the relevant file, navigate in Windows Explorer to the location of your file and select it. Then click Next.

Note: Users may name the import file according to whatever naming convention is most useful to them. The
import process keys entirely off the contents of the file, not the file name, so users have complete freedom in
naming import files. The file must either be an . XML file or a .ZIP file with an .XML contained inside.

Step 2 - Import Options

Translation lmport

Steps Import Options
L. Select File (@) Deliver File to Background Process
2. Import Options

Import Manually

The file was exported from process 21929, en-JS = fff (3:1)

[Demils

Back Mext Finish

The first option available on this screen, Deliver File to Background Process, is selected because you have
elected to import an XML file. Deliver File to Background Process is the best option.
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If the user selects the Import Manually option, a message in red text will appear in the Details section:

Translation lmport

Steps Import Options
1. Select File Deliver File to Background Process
2. Import Options

(@) Import Manually

Details

The file was exported from workflow 21929, endJs = fr (361).
Importing this file manually may mean that the process will not
terminate since it has not received this file.

Back Mext Finish

The last sentence states that, "Importing this file manually may mean that the process will not terminate since it has
not received this file." What this means is that because the user intends to import the file manually, the file will not
be delivered to the background process created to export the XML. The background process is paused at 50
percent post-export, and will not advance to completion (100 percent) unless the file is delivered back to the
background process. This means that if the user selected Import Manually, the translated data may be correctly
updated, but the background process will never advance. If the manual import completes with no errors, users
may update the values in the XML file and import it using the structured import. The background process will
complete.

The primary advantage of Import Manually as it relates to XML files is that it allows a user to import verified data
directly into STEP without the added steps of addressing a background process or forcing the data through
STEP's validation process. In practical terms, if a third-party translator has multiple changes to the same
translation, manually importing each updated XML file can be the most efficient way to update the translation
quickly.

With Deliver File to Background Process selected, click Finish. A File Uploaded to Process window
displays with a message like the one below:

File Uploaded to Process

@' The file xmitranslation_BGP_181287.7ip has been
; delivered to process 21929, en-UsS = fr (%3)

=

To check the progress of the import, click Goto Process. This will take the user to the background process
executing the import.

Once the user has accessed the background process, they should see that:
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« the Progress bar, which was halfway across and paused at 50 percent, is complete and shows a Done

status.
Pescriptiun 21929, en-US > fr
¥ecution Server doc-dev
oy
status succeeded
Created Wed Jul 20 16:02:09 EDT 2016
Started Wed Jul 20 16:02:29 EDT 2016
L1 a1=d 11 AR A A T A

» thefinal steps listed in the Execution Report section of the background report show that STEP has marked
the "translation of file" complete, and further states that "all pending files have been translated".

@ Execution Report

Importtranslation process started: BGP 181296 (Wed Jul 20 16:59:36 EDT 2016)

Splitting table data

Marking translation of file ‘translation-BGP_181287-frxml" as completed

Translation of iworkarea/background-processareaTranslation/BGP 181287 /convertedxml finished: 0 Errors, 0 Warnings, 0 Infos

All pending files have been translated.
H 4 | 1-250f25 | [ Pl Save... Truncate

To ensure the translated values were updated as planned, the user may select one of the translated objects,
switch the Context to the target language's context, and find one of the values that was set to translate. The
translated value should display.

For information on how to import Excel files, see the Importing Translation Excel Files documentation.

For more information on how to handle errors that may arise during import of a translation file, see the Handling
Translation Errors documentation.
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This topic will cover the process of importing translation Excel files, both via the structured translation process and
through the Manual Excel Translation Export, back into STEP. A successful import will complete a translation task.
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When the translation vendor has completed translation of the submitted objects in an Excel document, the Excel
file can be imported into STEP. Importing an Excel file will bring all of the new translated values into STEP in the

appropriate language contexts.

After the user has initiated an import, but before the import is executed by the system, STEP takes a series of
automated steps to ensure the translated content is handled correctly. Prior to executing an import STEP will:

« Check that the Excelfile is intact, meaning no sections have been deleted or amended

« Checkthat no values in either the source or target language have been modified in STEP since the file was

exported

« Check thatthe imported values match the attribute validation base types in STEP (for instance, if an attribute
restricted to accept only numerical values is given a free text value, an error is raised)

To start the Import Wizard, click File > Translate > Import Translation...

|Fi[e‘Edit View Mavigate Format Maintain Window Help

i (2

Import
Export

#° Reports
Bulk Update

Schedule Category Profiling

¥

>

>

&

=
Elh
5]

Data Objects...
Setup Objects...

Manual Excel Translation Export

Import Translation...

Change Translation

Schedule Data Translation...
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Step 1 - Select file

Translation Import

Steps Select File
1. Select File |C:‘|.I_Jsers‘|.|'|13rl‘|,Desktop‘l,Excel Files For Translation\French Translations. xlex
2. Import Options
Lok in: Excel Files For Translation w [’ [l P R

= French Translations.x st|

File name: |French Translations. xlsx |

Files of type:  7ip Files (*.zip), XML Files (*.xml) and Excel Files (*ds and =xsh)

Back Mext Finish | Cancel

In the Select File step of the Translation Import Wizard, the user must select the Excel file they wish to import.
Navigate in Windows Explorer to the location of your file and select it. Then click Next.

Step 2 - Import Options

Translation Import

Steps Import Options
1. Select File Deliver File to Background Process
2. Import Options

(®) Import Manually

Details
[] Automatically Approve Imported Translation

| Back || Next | Fmsh | [ Cancd

© Stibo Systems - Confidential - Release 10.1-MP4 (April 20, 2021) 64



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

The Import Options step of the Translation Import process will provide different options depending on whether
the Excel file to be imported was done as part of the structured translation process or as a Manual Excel
Translation Export.

If the import file was initially generated through the structured translation process, both import options, Deliver
File to Background Process and Import Manually, will be available. Make your selection and click Finish.

If you select Deliver File to Background Process, a message screen will display showing the process number
assigned to the import action, as well as an option to go directly to the background process executing the import.

If the user elects to go to the background process, and there are no errors, they will see that:

« the Progress bar, which was halfway across and "stuck" at 50%, will complete and show a Done status.

10U Do _ LOOLLI

Description 179927, en-US = Danish
Execution Server doc.day

Progress Done
Status sliccesded

« thefinal steps listed in the Execution Report will show that STEP has marked the "translation of file"
complete, and states that "all pending files have been translated".

% Execution Report

179927-179927 xls successfully imported.
Marking translation of file “179927-179927 xl5" as completed
All pending files have been translated.

The user may also select Import Manually for an Excel file generated through the structured translation. If the
import file was initially generated through the Manual Excel Translation Export process, then Import Manually
will be the only available option. After selecting Import Manually, click Finish and the updated values will be
added to the pertinent language. No background process is generated by this action. Any errors that occur will be
surfaced in a dialog that will enable a user to Save, View, or Discard an error report.

Users importing Excel files will have the option to Automatically Approve Imported Translation.
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Translation lmport

Steps Import Options

1. Select File
2. Import Options

Deliver File to Background Process

(®) Import Manually

Details
[] Automatically Approve Imported Translation

Back | | MNext Finish

Checking this box automatically changes the status of the object in the target language to Approved once the
import completes. The benefit to checking this box is that it removes the added step of manually approving the
object in the target language after an import. When multiple translations are executed, removing this step can

represent a significant time savings.

To ensure the translated values were updated as planned, the user may switch the Context to the target
language's context and find the values that were in the green-shaded cells. The translated values should appear in
the object record.

In some instances, these processes may generate errors. For more information on the kinds of errors you may
encounter, see the Handling Translation Errors documentation.
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Handling Translation Errors

After a translation vendor has completed translation of content, whether in an XML or an Excel file, the file is then
imported back into STEP to complete the translation process. This topic will cover where these errors are
viewable, what sort of errors a user is most likely to encounter, and how best to address those errors. By the end of
this topic, the user should be able to handle most translation errors that may occur.

Most translation import errors occur right after the user has initiated the import process. For more on importing
translation files, see the Importing Translation Excel documentation, or the Importing Translation XML
documentation, whichever is applicable.

Import Error Notifications

STEP makes the user aware of translation import errors in a number of ways, depending on the scenario. If, for
instance, the user is attempting to import a translation that has already been imported, STEP will respond by
displaying a message window entitled Error sheet....

[ Error sheet... *

The impart reported errars and an error sheet
has been created.

View Discard

This window will also display if the user has imported an Excel file manually and STEP has detected errors.
When this window appears, the user is given three options:

» Save: This s the best option if the user knows they want to save the error report. When a user clicks the
Save button, a Save As... window displays. Navigate to the place on your computer where you want to
store the Excelfile listing the errors. In the File name: field, add an appropriate title. An Excel file is
generated that describes the errors.

« View: This is the best option if the user is not clear whether they need to save the error report. Clicking the
View button brings up the same Excel error report the Save button generates. Once the user has viewed the
file, they may decide whether to save it or not.

« Discard -- Clicking the Discard button generates no report and initiates no action. The import process also
does not proceed.

The other way that STEP notifies the user that an import has generated errors is in the Execution Report section
of the import background process. When a translation import is initiated in STEP, the automated steps appear in a
list. If, during the course of executing those actions STEP detects an error, the error will be listed in the report.

For instance, if the XML being imported is malformed, meaning the structure of the XML is in the wrong format,
missing an end tag, etc., STEP will generate an error. In the below instance, part of the XML was deleted in error,
saved, and then imported.
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Analyse

Impaort translation process started: BGE 181341 (Thu Jul 21 14:28:47 EDT 2016)

= Splitting table data

must be followed by either attribute specifications, =" or "=".
| 22 Translation failed with 1 error

I 22 File translation-BGF 181340-Hebrew xml could not be parsed : Received unexpected:
class orgxml sax.SAXParseException: Element type "ClassificationReference”

2= Pending files: 1
22 1files are pending.

H 4 | 1-260f26 | b e Save...

Truncate
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Translation imports can import with warnings, where only the values affected by the warnings will not import. All

other values unaffected by warnings will import with no issues.

Itis also possible to view the Execution Report for in-progress translation imports by finding the relevant Active
Process in the Background Processes tab. To access the background process, click the BG Processes tab,
expand Translation, expand Active Processes, and then select the pertinent process. The Execution Report

generated for that import is viewable.

Excel Error sheet

There are a number of ways to view the Excel file listing the translation import errors:

« Access the background process specific to that import and, if errors are present, click the disk icon ( )

located in the Error file: row in the Result section.

@ Result

Translated file: wmltranslation_BGP_181340.zip =
Error file: report_BGP_181341.err

Importing franslated file failed, please correct errars,

For ¥ML, reimport changed XML file, For Excel reimport updated error sheet,

o Click View or Save when the Error Sheet... pop-up displays upon import.

Below is an example of how the Excel document will be formatted. Only one error is listed in the Validation error
column, though in some instances an error sheet can display multiple errors.
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53 exceltranslationerror30188.xls il J B[] 3

A B C | D =
| 1 |This sheet is a Stibo Systems translation excel sheet. Please do not change the structure of the sheet, I
?
: Product: Battery 3638
I Source: English Target: German Validation error
Rl Battery 3638 Battery 3635
The source value has been changed since
RO, Was!
Text attribute [text( This battery cannot last forever Diese Batterie kann nicht immer dauern. "This battery cannatlast forever’
i3 haw
B "This hattery cannot lagt forever”
? v
Nn 4 » M|\ Translation sheet / | 1 | | ﬂ v

In this example, the English value "The battery cannotlast forever" was included in the initial translation export into
German. After the translation export but prior to the import, the value was corrected in the English context to be
"The battery cannot last forever". The error was thrown because the English value the STEP validation was
expecting no longer matched the value in STEP. The status for this translation would flip from In Progress to Re-
Translation Needed. To fix this error, a user might consult directly with the translation vendor to determine what
changes, if any, would be required to make the German value accurate based on the updated English value. Once
the German value is deemed correct, the edit can be made directly in the Excel error sheet and then imported.
Following that, the translation status can be manually changed from Re-Translation Needed to Up to Date,
completing the translation.

The Validation error column can contain a number of errors. Below are some of the most common error
messages a user may encounter:

o The Product does not exist

o Valueis not a “humber, integer, fraction...”

« Invalid Unit for Attribute

« The source Value has been deleted since export. The Value was “[value]’

« The target Value has been deleted since export. The Value was “[value]”

« A source Value has been added since export

« Atarget Value has been added since export

» The source Value has been changed since export. The Value was “[value]’

« The target Value has been changed since export. The Value was “[value]”

« The Unit of the source Value has been changed since export. The Value was “[value].”
« The Unit of the target Value has been changed since export. The Value was “[value]”

« The order of multi Values has been altered. Correct the order or delete multi Values in file.

In some cases, handling these errors will require the user to manually change the translation status and then re-
export (as described in the example above). In some instances, users may correct the error directly in the error
sheet and then import the updated error sheet. For instance, if the value is free text, but the attribute only accepts
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numerical values, then the user can address this error directly in the error sheet by amending the error and
importing.

For more information on changing translation status, see the Changing Translation Status and Setup
documentation.
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Changing Translation Status and Setup

This topic covers a series of manual steps users can take to quickly rectify issues that may come up during the
translation process. Whether that means accommodating a late change to a shipped translation, or fixing an
incorrectly set source language, this documentation provides guidance on how to use make these adjustments.
Users who have read and understood the content in this topic will know how best to use the Change Translation
and Change Translation Status features.

Though STEP enables users to automate a number of translation tasks, STEP also provides the user with some
flexibility to manually address errors and late changes. For example, let us say a translation file has come back
from the translation vendor and been imported back into STEP. This automatically puts the object into Up to Date
status. But shortly thereafter, the customer has some late updates. To import these updated values, the object's
status must first be manually changed from Up to Date to In Progress. Once changed, the updated file can be
imported.

Changing the Translation Status

Translation relations, or the link between a source language and a target language, are established automatically
when translation exports are done. In most cases these relations won't need to change, but on rare occasions the
translation relation must be changed manually. Translation relations need to be changed manually when:

« the shipped translation file is corrupt due to a network or hard disk issue. This necessitates resending the
translation export file, which would require manually changing the status from In Progress to Re-
Translation Needed.

« the shipped translation file is missing some content that should have been included. This necessitates
resending the translation export file, which would require manually changing the status from In Progress to
Re-Translation Needed.

To change the translation status, take the following steps:

« Inthe Tree tab, select the object whose status needs to change. Click the Status tab, and then expand the
Translation section by clicking the flipper. Find the translation relation (source language to target language)
where the status needs to be changed, and then click into the cell in the Status column. A dropdown
displays with the available statuses. Select the appropriate status and the change is complete.
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' Translation
Master : [Enjsh -
Source ¥ [Target hl% >
* English French
@ Re-Translation Meeded
. In Progress

Changing the Source Language

As with the translation status, the source language is established when a translation export is first created and
rarely needs to be changed. But there are some instances where manually changing the source language is the
correct option. For instance, if the user selected French as the source language instead of US English and
identified their error shortly after exporting the translation file, manually changing the source language is the right
option.

To change the source language, take the following steps:

1. Inthe Tree tab, select the object whose source language needs to change. Click the Status tab, and then
expand the Translation section by clicking the flipper. Find the translation relation (source language to target
language) whose source language needs to be changed, and then click into the cell in the Source column.
Selecting a new language completes the task. If the source language has been incorrectly set for one
translation, it likely needs to be changed for all. If this is the case, repeat this step for all applicable translation
relations.
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nid=108200&contextid=Context18id=" @ ¥ E [E coto [1DiName | 5
18216 L O rev.0.2 - Status

Commercial || Tables || Category Profile || Proof View F State Log || Tasks
R

| Productk ” Sub Products " References eferenced By " Images & Documents ]

* Main Main Main 0.2
* WApproved Approved Approved n.2

> [Status >

In Progress

In Progress

In Progress

In Progress

In Progress

Important: Changing the source language for an object is not possible if no translations have previously
been done for the new source language. For example, let us say an object has only one translation
relation: English (source) to German (target). You want to change the source language from English to
French. If the object has not previously been translated into French, French cannot be selected as the new
source. In this example, only German could be a selectable source language.

2. Next, change the translation status from In Progress to Re-Translation Needed.

3. Finally, re-export the newly amended translation because any previous export files will be nullified by the
change of source language.

As with any significant error that occurs in the translation process, it is always recommended practice to
communicate with your translation vendor. Given the specific translation configuration you have established with
the vendor, they may provide useful guidance about how best to rectify the error, including steps they can take on
their side.

Changing the Translation Setup

If multiple objects require a change to either their source language or translation relations, the Translation Setup
tool enables you to change translation relations on many objects in a single step.
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Important: Use the Change Translation Setup tool with care. Changes to the master language or
translation relations can have a major impact on the translations in your system. We recommend using this
dialog when you have, for example, a limited set of objects where you need to change the master language or
translation relations.

1. Inthe File menu, click Translate, and then choose Change Translation. The Change Translation Setup
dialog appears.

Change Translation Setup

Input file:

Header lines toignore |0

Dz in file are for: {® Product () Asset () Classification () Attribute  (O) List Of Values

[] Clear all translation relations (done before above operations)

[] 5et master to iGerman |

Source > |Target » [Status > |

Create translation relation

| v

2. Inthe Input file field, click the ellipsis button (|...)), and then select the relevant text file. The text file must
contain the IDs of all objects whose translation relations and status you want to change.

Important: Only .txt files can be used. A common way to create this file is to export the relevant objects
from STEP into Excel, and then copy and paste the data from that Excel into a .txt file.

3. Ifthere are header lines in the text file that you want the system to ignore, enter the number of header lines in
the Header lines to ignore field. The default setting is 0.

4. FortheIDs in file are for element, select which of the listed object types the IDs in the .txt file refer to. The
Change Translation Setup tool can only take action on one of the listed object types (Product, Asset,
Classification, Attribute, Lists Of Values) at a time.

5. Check Clear all translation relations if you want to remove all existing translation relations on the matched
objects. In practice, this will remove all translations that have been created for a given object.

6. If youwantto change the source language for the same target language across multiple objects (e.g., all
translations into French), check the box for the Set master to field, select the desired target language that,
and when you click OK, any translation relationships with the selected language as the target language will
swap their current source-target translation relation.
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7. Clickthe Create translation relation text to specify any new translation relation you want to apply to the
objects listed in the .txt file. However, be aware that:

« IfClear all translation relations is checked, all existing translation relations are removed from the
matched products, and the relations specified in this dialog are applied to the matched products.

« IfClear all translation relations is not checked, the existing translation relations on matched products
remain as they are, and the relations specified in this dialog are added to the matched objects.
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Searching for Translation Status

This topic addresses how to search for an object's translation status (Up to date, Re-Translation Needed, etc.)
using the advanced search functionality. By reading through this topic, a user should be able to search for and
locate an object's translation status in the STEP Workbench.

STEP enables users to quickly search for the translation status of a given object using the Advanced Search
capabilities located on the Search tab. Using the Translation Status and Search Below search criteria together,
users can find out not only whether an object's translation into a target language is Up to Date, but, for example,
how many products in a specific context are in Re-translation Needed status.

This functionality may prove useful in a number of common scenarios. For instance, if you know some products
were updated after the translation export was sent for French translation, you may want to alert the translation
vendor so they know to expect updates for those products. To do this, you could run a search of all relevant
products translating from English to French, that are in Re-Translation Needed status. This would provide you
with a reliable list of all products to query with your translation vendor.

Below is a step-by-step description of how to initiate an advanced search for objects by their translation status.

Initiating a translation status search

1. Verify the relevant context has been selected.

| | Context |English US B

Correct selection of context is important because it restricts which languages can be searched as you continue
to build the search. More on this in the description for step five.

2. Clickthe Search tab. The panel below will display in the left navigation panel.
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[ context \English US

& advanced

<
m X = [ | 3 3
l;%l 'ﬂi i | Reset . Sear::h. |
Show Details
[ [Name >

[ Systermn Setup H BG Processes (3) ]

3. Clickthe Search Criteria Type Selector ( [Se=h ~) and select Translation Status from the dropdown.

4. Inthe Type dropdown, choose the object type you want to search for. The user may choose between these
object types: Classification, Product, Asset, Attribute, and List Of Values.

| Translation Status = =

Type:  Product ~
-Langu{Classification

Asset
@ T{Attribute
List Of Values

-Translation Status

[ Re-Translation Needed

[]In Progress

[]Up to Date

[ ] Mot Translated

5. Inthe Language area, select Source language or Target language, and then choose the relevant
language. You may notice that, as default, the source language is set to your current context and grayed out. It
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may be changed, but the moment you select Source Language, the Target Language switches to the language
your context is currently set to.

Search
~ [Translation Stats |
Type: ?Elassiﬁmﬁon
rLanguage
(7 Source Language ;En_glish
i@ Target Language | ||Dutch
Danizsh
-Translation Status Dutch
lish
[] Re-Translation M =g
[] In Progress German
Hebrew
[ Up to Date Language Root
UK English

[] Mot Translated

6. Inthe Translation Status area, check one or more of the listed status types you would like to include in your
search. For instance, including the statuses Re-translation Needed and In Progress in your search will bring
up all objects of the object type selected in step four that are currently in either Re-translation Needed or In

Progress status. These are the status options available to include in your search:

Status Description

Re-translation Needed

Master language has been changed since last translation.

Up to Date

Master language has not been changed since last translation.

In Progress

Translation has been exported, but not yet imported.

Not Translated

Object has never been translated.

7. Addthe Search Below search option. The Search Below criteria is required to ensure a complete search
result of objects that meet the configured Translation Status search criteria. To add the Search Below
search criteria, click the Add Criteria / Operator button ( ), and then click the Search Criteria Type

Selector ( [Seach =) Select Search Below from the dropdown.
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8. Click the ellipsis button to the right of the field to select which node the search should be applied to. Click
'Select' to apply the highlighted node to the search criteria.

©- Details

| Translation Status =
| Search Below ¥ -
’V,F'rimar\yI Product Hierarchy (Product hierarchy root) |Z|
[dh | Reset || Search |
Search Result
[ TName I_Il Search Below... >
E}|j Products s
--1'_=| Footwear
-- [ oateh
cm
|1r|_| Thper cody Wear

[+-[[T) Head Wear
rj Qutdoor Apparel and Accesari

--[j Hardware
(-5 Displays &

al . Select Cancel

Important: To avoid performance slowdowns when using the Translation Status and Search Below
criteria together, users should precisely define which nodes should be selected for Search Below. For
example, selecting a root node can potentially result in poor performance for the entire query.

9. Click Search.
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[] Mot Translated

[¥] Up to Date ‘ ‘

(g8 [ Reset ]l Search I

10. Ifthe search has generated results, they will display in the Search Results List, located beneath the Add
Criteria / Operator button (223,

EEE | Reset || Search |
Displaying 3 of 3 results Show Details
_Name >

> | .. 18207-011 ID = 18207
> W™ 21933 ID = 21975
* | .. 321934-24 ID = 21934

-Operations on Entire Result

11. Clicking on any of the objects listed in the search results will take the user directly to the object.

For more information on the search functionality, see the Search documentation in the Getting Started / User
Guide documentation.
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Scheduling a Collection of Objects for Translation

This topic covers the ability to schedule all objects in a collection for translation. In order to understand how this
functionality works, it is beneficial to ascertain the actions that take place:

« An event processor plugin (the Asynchronous Translation Message Processor) processes events for the
objects included in the collection.

« Togenerate an event per object in the collection, a bulk update action (configured with a business action that
can generate derived events) must be run on the collection.

« Once the bulk update action is run, the event processor plugin will read the events dependent on the
scheduling configuration of the event processor. Also, the event processor can be configured to batch together
the events, resulting in a reduced number of translation files.

To schedule a collection of objects for translation, there are several requirements (specifically, creating and/or
configuring components within System Setup) that need to take place prior to scheduling the collection for
translation. While the majority of these actions do not need to be performed in the order they are discussed, users
may find it beneficial to do so. These include:

» Creating a derived event

» Creating and configuring an asynchronous translation service
« Creating and configuring an event processor

« Creating and configuring a business action

» Creating a collection

« Running a bulk update

Create a derived event

In the example below, a derived event named 'AsyncTrans_English_to_French' has been created. This derived
event will be selected later in this topic when configuring the business action and the event processor.
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ﬁ LewTrans
[+-[5] GDSMReceiverRestBusinessAction:
=[] Global Business Rules
g Default Audit Business Action
[fEE Actions
-5 Conditions
>[_°_E; Libraries
L. ather
----- [5] Inbound Integration Endpaints
----- [(5] Match Codes and Matching Algorit]
+-[5] Outbound Integration Endpaints
[+ PDS Inbound Setup Group
[+-(75] PDS Qutbound Setup Group
----- (5] Status Flags
----- [4] suffidencyDataContainer
[+-[55] Web Uls
----- 5] Workflow Profiles
----- 5] Workflows

L]

Derived Events

€ Derived Events -

T ISTIBOSYSTEMS

» Asset Keywords Event

I > Asym?rans_ﬁr*rglish_to_ French

» Start_Translation_Lion_To_Fr

'1

» |An|:l1:| Derived Event Type

e MASTER DATA MANAGEMENT

For more information, see the Derived Events topic in the Events section of the System Setup / Super User

Guide documentation.

Create and configure an asynchronous translation service

An asynchronous service must be created. Note the name of the asynchronous translation service in this example,

'File Exchange Service, ' and the translation configuration, 'English to French.'

© Stibo Systems - Confidential - Release 10.1-MP4 (April 20, 2021)

82



-0 Attribute Groups
i {E) Attribute Transformations
=[] Action Sets
I | Contexts
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----- i--[75] Asset Import Configurations
EI 5] Asynchronous Services
-2 File Exchange Service|
t-[75] Completeness Metrics
t|-[75] Data Proflie Configuration
H-[75) DataSuffidencyScoreGroup
t-[75] Event Processors
-[5] GDSNReceiverRestBusinessActions
(5] Global Business Rules
----- {5 Inbound Integration Endpoints
----- [%5] Match Codes and Matching Algorithms
-5 Outhound Integration Endpaints
-] PDS Inbound Setup Group
B-[F5] PDS Qutbound Setup Group
----- (5] Status Flags
----- (5] SuffidencyDataContainer
5] Web Uls
----- 5 Workflow Profiles
..... @ Workflows
--[Z| Derived Events

-z Object Types & Structures
. Taae
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€File Exchange Service rev.0.1 - ﬂS‘g,Frl|::hr'|:::|r||:::|us Service Configurati... -k

Asynchronous Service Configuration Type Status

'P__

Marme Value
> ID File Exchange Service
> Mame | File Exchange Service |
* Dbject Type Asynchronous Service Configuration Type
» Revision 0.1 Last edited by USERK on Tue Apr 30 13:28:28 EOT 2019
» Path Aeynchronous Services/File Exchange Service

'P__
> Bervi

File Exchange Service

hotfolder

> [In folder n

Out folder out

>
|* |Edit Configuration
'P__
» Server Polling Interval in Minutes

* Maximum Mumber of Processed Jobs to Retain 100

Poller Status

» Maximum Age of Processed Jobs (in Days) 30

’ e |
| * |Edit Configuration

¢ —
Translation configuration >

» English to French |||‘}<|
> | Add

For more information on asynchronous translation services, including the File Exchange Service, see the
Configuring an Asynchronous Translation Service topicin the Data Integration documentation.

Create and configure an event processor

An event processor (in this example named 'AsyncTrans') with the Asynchronous Translation Message Processor
processing plugin selected must be created in order run the bulk update.
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System Setup AsyncTrans - Event Processor
-5 Attribute Groups ™ Event Triggering Definitions || Background Processes || Statistics || Error Log Excerpts
Attribute Transfo + ID BsyncTrans A
" Action Sets * Mame AsyncTrans
-- Contexts
;ﬁ InDesign Queus > Type Event Processor
- Lists of Values /L > Last edited by 2019-06-25 16:44:45 by USERK
S Eli
I g Asset Analyzer » Enabled Ves
----- Asset Import Con
>
1 88 Aoycvormusse | |17 Processr Sz R —
R 9 Coofguwaten

'=3’ File Exchange D MName
E Ccmpleteness Me User running event processor plugin DBA
- 5] Data Profiie Confi
ra_gl DataSuffidencyse umber of events to batch 1000
L—"_I@ Ewvent Processors Days to retain events 0
[ﬂ Queue for event processar EVPROC
ﬂ Data Sufficier
Maximum number of old processes 100
[ﬂ LovTrans
[-[75] GDSMNReceiverfe: Maximum age of old processes in hours 168
&1+ Global Business R Limit of lines in execution report 1000
- Default Audit -
. Processor ﬂﬂsynmronwsTranslaton Message Processor |
- [F5] Actions
- [5] Conditions Schedule Mot scheduled
- [5] Libraries Cueue Status Read Events
51 ather Unread events (approximated) | Click to estimate ... |
----- [5] Inbound Integrat N ;
_____ (5] Match Codes and + || Edit Configuration

®CurentBackgrond Processlog
b

FY

Note thatin Step 3 (Configure Processing Plugin) of the Event Processor Wizard, the Event Type (in this case, a
derived event) and the Asynchronous Service were both created earlier in this topic. The Translation
Configuration, 'English to French,' is the translation configuration for the asynchronous service 'File Exchange
Service.' If desired, schedule the event processor to run in Step 4 of the Event Processor Wizard; in this example,
the event processor is scheduled to run every 60 minutes.
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Event Processor Wizard

Steps Configure Processing Plugin

1. Identify Event Processor
2. Configure Event Processor Translation Event Configuration Event Type * synchronous Se... * Translation Configuration
3. Configure Processing Plugin AsycriTrans_English_to_ French File Exchange Service English to French

4., Schedule Event Processor > | add

5. Configure Error Reporter Processing Plugin

W

Translation Completed Business Action

Translation Failure Business Action

£ >

Back Finish Cancel

Event Processor Wizard

Steps Schedule Event Processor

1. Identify Event Processor Start
2, Configure Event Processor
3. Configure Processing Plugin
4. Schedule Event Processor (@) Every
5. Configure Error Reparter Processing Plugin O Weekly

() Never &0 minute:

() Monthly
() Later

Start every 60 minutes

Back Mext Finish Cano

For more information, see the Asynchronous Translation Message Processor Processing Plugin
Parameters and Triggers topic in the Event Processors section of the System Setup / Super User Guide
documentation.

Note: The Asynchronous Translation Message Processor processing plugin is only available to users that
have the external-async-kernel component installed in their system. For more information, please contact your
Stibo Systems representative.
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Create and configure a business action

A business action that sends a derived event must be created and configured. The image below demonstrates an
example of a properly configured business action capable of generating a derived event per object in the
collection. This business action will be referenced later in this topic when running a bulk update is addressed.

View Operation

[ Eweoute JavaSoipt =

Binds: ¢ Ginds
Variable name » |Binds to » |Parameter >
eventQueus Event Queue synclrans (Asynclrans
event Derived Event Type sycnTrans_English_to_ French (AsyaonT.
node Current Object

Messages: ¢ Messages
|'I.-'ariable name > |I'~"Iessage > ITranslaﬁnns >

Javasoipt: | 1 eventQueue.gueuelerivedEvent(event, node) 2

W

Edit externally

£ >

Note that in the example above, the event processor 'AsyncTrans' has been selected in the first row's Parameter
cell, and the derived event'AsyncTrans_English_to_French' has been selected in the second row's Parameter

cell.

For more information, see the Business Actions topic in the Business Rules documentation.

Create a collection

In the example below, a collection consisting of 220 objects that require translation from English to French has
been created.
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--i Primary Product Hierarchy
EI@ Collections
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=6 to translate
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| G | Daka Profile || Log

@ Desaipfon

Mame *| » |Value
» D 140219
* Mame Eng_French
* Estimated Amount of Objects 220

* Search URL

tep:/fsearch?args0. 0=nod

* Last edited By

2019-05-25 15:17:07 by US

E"—|

For more information on creating collections, see the Creating Collections topic in the Collections and

Collection Groups section of the Getting Started / User Guide documentation.

For more information on searching for translation status, see the Searching for Translation Status topicin the

Translations documentation.

Running the bulk update

To generate a derived event per object in the collection a bulk update action must be executed:

1. Right-click the desired collection and select 'Run Bulk Update.' In this example, the collection 'Eng_French' has

been selected.
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#-[7) Assets Collection |EPEERGE

--1‘_‘=| Classifications

--1'_'=| Configurations Name s | 3 |value
i {2y Index Words
i > ID 140219
[+-4_ Target Markets
- I Publications * MName Eng_French
[+-{3 Primary Product Hierarchy » Estimated Amount of Obje...| (220
El@ Collections » Search URL step: fsearch?args0. 0=nodetype 3%3dprog
&[5 Lovs
53[5 Temporary Collections > Last edited By 2019-06-25 15:17:07 by USERK
El@ to translate - Statistics
il eCatalogs ] Run Bulk Update
i3 Recyde Bin g Export Data Below
Republish...
Refresh

Edit Search Criteria...
7 Delete

Search Below

The Bulk Update Configuration wizard opens.

2. Inthe Bulk Update Configuration window, select 'Create New Configuration' and click 'Next.'

Bulk Update

Steps Configuration

1. Configuration
2. Operations

3. Parameters

4. Preview

5. Advanced

(") Use Existing Configuratiori

{®) Create New Configuration

Back Mext Finish Cancel
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3. From the dropdown menu, select 'Run Business Rule' and for the Business Rule Action, select the business
action created earlier, 'AsyncTransBA.'

Bulk Update

Steps Operations
1. Confguraton T
=L iER e ’VEusiness Rule Condition
3. Parameters Business Rule Action | AsyncTransBA (AsyncTransBa)
4. Preview
5. Advanced

Add Operation

Back Mext Finish Cancel

4. Click 'Finish' to run the bulk update or 'Next' to preview the items within the collection and / or configure the
Advanced screen.

Once 'Finish' is clicked, the background process status window opens, which indicates the status of the bulk
update.

Background process status - (100%)

A backaround process with ID: "BGP_305746" has been started

Description Bulk Update

g

Status Fu:ceeded - (#errors: 0, Fwarnings: 0)
Go to process Close

5. Click'Go to process' for further information about the background process or 'Close.’

For more information, see the Bulk Updates documentation.

Now that the bulk update has been run using the business action described above, the event processor configured
with the Asynchronous Translation Message Processor processing plugin, when run, will send the objects

included in the bulk update to the translation service specified during the configuration of the asynchronous
service.
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Scheduling a Data Translation

Translations based on saved translations configurations can be scheduled to be executed at a later time, either as
arecurring export, or as a one-time export. There are several different scheduling options available in the
Schedule Data Translation wizard, providing users with maximum flexibility when managing translation exports.
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Before a translation configuration export can be scheduled, it must be created. For information on creating a
translation configuration, see the Starting a Structured Translation topic.

To schedule a data translation:

1. Right-click the desired translation configuration and select 'Schedule Data Translation..." OR select 'File' >
'"Translate' > 'Schedule Data Translation...' from the workbench menu.

E}|:| Export Configurations
. [=)) GDSN_Export

1498

* Mame

Trang

GDSNEpor

rj Asset Push Coni
- [7] Auto Classificati
|j Portal Configura
|j Smart Sheet Cor &
-2 Transformation L
--|'_‘=| Elasticsearch Col
- [Z] Index Words
- Target Markets
[ [§l Publications

Edit Asset

External Viewer

Edit import configuration
Import data...

Edit export configuration

Run Translation

Edit image conversion configuration

(= [[Z) Primary Product Hier @ Export data..
=+ All Products Mfg
EIE Air Care “E Schedule Data Export...
. B[ Ar Carel B Schedule Data Translation...
| -8 Air

File Edit View Mavigate Format Maintain Window

Help

Translate
Import
Export

Fid Reports
Bulk Update

Schedule Category Profiling

>

¥

¥

Data Objects...

Setup Objects...

Manual Excel Translation Export
Import Translation...

Change Translation

Schedule Data Translation...
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The Schedule Data Translation wizard opens.

Schedule Data Translation - TransFr

Steps Select Translation Configuration

1. select Translation Configuration
2. Schedule Process
3. Mame Process

Configuration: :TransFr

Back Finish | | Cancel

The Configuration parameter text field will populate with the name of the selected translation configuration (in
this example, 'TransFr').

2. To select a different translation configuration, click the ellipsis button (|...|) and select the desired translation
configuration. Otherwise, click 'Next.'

The Schedule Process dialog opens.

Schedule Data Translation - TransFr

Steps Schedule Process

1. Select Translation Configuration Start
2. schedule Process . :
3. Mame Process

() Monthly
() Later and repeat

Start now

Back Mext | | Finish Cancel

3. Select one of the options available for scheduling the data translation export. Information regarding each option
is explained in detail below.

© Stibo Systems - Confidential - Release 10.1-MP4 (April 20, 2021) 92



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Important: Consider the time zone of the application server compared to that of the workbench (the client)
where the schedule is created or viewed. When scheduling a job, the local time zone is displayed in the
workbench, but the time zone of the server is used to run the background process. Although displayed, the
time zone of the client is not included in the instruction to the server to run the job. This can cause confusion
about when the job will run since the scheduled time is not automatically converted to accommodate
potential differences in time zones.

Now - Will initiate the translation process when the user clicks 'Finish.'

Later - Brings up two additional fields, Start at (hh:mm) and Start on (yyyy-mm-dd). The user sets the time
and date and STEP completes the translation export at the configured time. An example of these fields
configured is shown in the screenshot below:

Start at (hhi:mm): 15:28

Start on {yyyy-mm-dd): |2020-07-21

Weekly - Allows the user to create a recurring export to execute once or multiple times a week. The user sets
the time and date to start the recurring weekly export, the date at which the recurring weekly export will end,
and then the day (or days) of the week the export should run until the configured interval has elapsed. One or
all days of the week can be selected. An example of these fields configured for recurring weekly export is
shown in the screenshot below:

Start at (hb:mm): 15:23
Start on {yyyy-mm-dd): 2020-07-21

End on (yyyy-mm-dd): |-

Every: Mon [ | Sat
[(1Tue []5un
[] wed
[ Thu
[E] Fri

Monthly - Allows users to set a recurring translation export once a month. The user sets the time and date to
start the recurring monthly export, the date at which the recurring monthly export will end, and then which non
specific day (or days) in the month the export should run until the configured interval has elapsed. For example,
the monthly export can be scheduled for the first Monday of every month. An example of these fields
configured for a recurring monthly export is shown in the screenshot below:
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Start at (hhmm): |15:28

Starton (yyyy-mm-dd): |2020-07-21

End on (yyyy-mm-dd): |—

Every: [Fl's-t

L

Monday

4

Later and repeat - Allows users to create a recurring export that can be run multiple times a day. In addition to
the time and date fields, the user can set the number of minutes between auto-exports. An example of these
fields configured for recurring export is shown in the screenshot below:

Start at (hh:mm): 05:46 |

Starton (yyyy-mm-dd): | 2020-07-21 |

Minutes between attempts |30 |

4. Once an option is selected, click 'Next.'

The Name Process dialog opens.

Important: The image below displays how the Name Process dialog would appear if the user selected
'Now' as a scheduling option. Selecting any other available option will result in an additional parameter
within the dialog, as decribed in detail later in this topic.
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Schedule Data Translation - TransFr

Steps Name Process

1. Select Translation Configuration
2. Schedule Process
3. Name Process

Process Mame: | Translate using TransFr'

[ Ba& Mext Can::el. |

5. Inthe'Process Name' field, input a name for the scheduled translation export process. By default, if no name is
provided, the name of the process will be the name of the configuration selected for translation (i.e., 'TransFr').

If the user selects a scheduling option besides 'Now' in the Schedule Process dialog, the Name Process
dialog will contain an additional parameter titled 'Schedule Process Name.'

The 'Schedule Process Name' parameter will contain the information provided by the user in the Schedule
Process dialog. In the example below, the user selected 'Later' and provided specific details regarding the
'Start at' time and 'Start on' date in the Schedule Process dialog. These details are displayed in the Name
Process dialog, which are also displayed in the image below. Similar to the 'Process Name' parameter, The
'Schedule Process Name' parameter can also be edited.
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i Steps Name Process

1. Select Translation Configuration

2. Schedule Process O Now Start at (hh:mm): 16:25
3. Name Process

® Later Start on (yyyy-mm-dd): i2[:-2D-[:-?-24

O Weekly
) Monthly

O Later and repeat

Start at Fri Jul 24 16:25:00 ET 2020

Steps Name Process

1. Select Translation Configuration
2. Schedule Process

3. Name Process

v

Schedule Process Name: | Translate using 'TransFr' - Start at Fri Jul 24 16:25:0

Process Name: Translate using 'TransFr'

6. Click'Finish' to close the Schedule Data Translation wizard.

Reviewing Product Translation Status

When a structured translation export process has been initiated, a few final steps must be taken in that export's
background process. If 'Now'is selected as a scheduling option in the Schedule Process dialog, a small window
will display showing two options; 'Go to Process' and 'Close.'

Starting process Translate using "TransFr

Starting process "Translate using TransFr'™ (Translation).
Process started

To review product translation status:

1. Click'Go to process' to go directly to the export's background process.
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2. Thetranslation produces an Excel file listing all of the objects that are included in the export. These listed
objects are the same objects that displayed on the Feedback screen. To view the spreadsheet, click the disk
icon and follow the prompts.

?

Step Query Done

Review outcome of the translation analysis: statusfile_BGP_13500.c5v 1=
Do you want to export these products for translation? [ ves |[ Mo |

3. A prompt below the report file asks, "Do you want to export these products for translation?" Click 'Yes' to
proceed with the export. Click 'No' to abort the export. If the user has checked the box for Skip Verification on
the Delivery screen, then the export proceeds directly to generating an export file, and there is no question for
the user to answer.

4. To export the products for translation, click 'Yes." A zip file is created that contains the data to be translated.

If you click 'No,' the translation export is ended, and the translation status of the selected objects is not
changed.

4. Click the 'Save'icon to save the zipped translation file.

PResit

Step Wait for Translation
Review outcome of the translation analysis: statusfile_BGP_13500.csv =l
Exported translation files: ymitranslation_BGP_13500.zip H

i
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